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Legal Information

The information provided in this document contains general descriptions, technical
characteristics and/or recommendations related to products/solutions.

This document is not intended as a substitute for a detailed study or operational and site-specific
development or schematic plan. It is not to be used for determining suitability or reliability of the
products/solutions for specific user applications. It is the duty of any such user to perform or have
any professional expert of its choice (integrator, specifier or the like) perform the appropriate and
comprehensive risk analysis, evaluation and testing of the products/solutions with respect to the
relevant specific application or use thereof.

The Schneider Electric brand and any trademarks of Schneider Electric SE and its subsidiaries
referred to in this document are the property of Schneider Electric SE or its subsidiaries. All other
brands may be trademarks of their respective owner.

This document and its content are protected under applicable copyright laws and provided for
informative use only. No part of this document may be reproduced or transmitted in any form or
by any means (electronic, mechanical, photocopying, recording, or otherwise), for any purpose,
without the prior written permission of Schneider Electric.

Schneider Electric does not grant any right or license for commercial use of the document or its
content, except for a non-exclusive and personal license to consult it on an “as-is” basis.

Schneider Electric reserves the right to make changes or updates with respect to or in the content
of this document or the format thereof, at any time without notice.

To the extent permitted by applicable law, no responsibility or liability is assumed by Schneider
Electric and its subsidiaries for any errors or omissions in the informational content of this
document, as well as any non-intended use or misuse of the content thereof.



Important Safety Information

Read these instructions carefully and look at the equipment to become familiar with the device
before trying to install, operate, service, or maintain it. The following special messages may
appear throughout this manual or on the equipment to warn of potential hazards or to call
attention to information that clarifies or simplifies a procedure.

indicates that an electrical hazard exists which will result in personal injury
if the instructions are not followed.

f j The addition of either symbol to a “Danger” or “Warning” safety label

This is the safety alert symbol. It is used to alert you to potential personal injury
& hazards. Obey all safety messages that follow this symbol to avoid possible injury or

death.
A DANGER
DANGER indicates a hazardous situation which, if not avoided, will result in death or serious
injury.
A WARNING

WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

A CAUTION

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

NOTICE

NOTICE is used to address practices not related to physical injury.

Please Note

Electrical equipment should be installed, operated, and maintained only by qualified personnel.
No responsibility is assumed by Schneider Electric for any consequences arising out of the use of
this material.

A qualified person is one who has skills and knowledge related to the construction, installation,
and operation of electrical equipment and has received safety training to recognize and avoid the
hazards involved.
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1. Introduction

General Description

The RTT80 Temperature Transmitter is a microprocessor-based temperature transmitter that
receives input signals from thermocouples, RTDs, resistance (ohms), or millivolt sources. It is
offered in a basic module package or with a dual compartment housing option, and utilizes

HART® revision 7 communications protocol. SIL functional safety certification is available as an

option.

Reference Documents

For additional and related information, refer to the documents listed in Table 1.

Table 1. Reference Documents

Document Description
PSS 2A-1F8 A Model RTT80 I/A Series® Temperature Transmitter
MI 020-580 RTT80 I/A Series® Temperature Transmitter FM/CSA Safety Information
MI 020-581 RTT80 I/A Series® Temperature Transmitter ATEX/IECEx Safety Information
MI 020-582 RTT80 I/A Series® Temperature Transmitter with HART 6 Protocol
MI 020-584 2-Channel Temperature Transmitter RTT80, HART Protocol Functional Safety Manual
DP 020-580 Model RTT80 I/A Series® Temperature Transmitters
PL 008-680 Model RTT80 I/A Series® Intelligent Temperature Transmitters

11



MI 020-585 — November 2022 1. Introduction

Transmitter lIdentification

See Figures 1 and 2 for typical agency and data labels. For transmitters enclosed in a housing, the
basic unit agency label is located on the basic unit and the applicable agency and data labels are
externally mounted on the transmitter housing.

— NOTE
Figures 1 and 2 show typical data plates. For a recapitulation of the specific
information that applies to each agency certification, see “Electrical Certification” on

page 19.

Figure 1. Typical Identification Label for Housing and Sensor Mounting Code BB (SIL and non-SIL)

Basic Transmitter Agency Labels

Module (Code BB)

SNz KOO
DevRev: 2

FW. 01.01.04

Input: 11-30V ===
Made in Germany 2014
Current consum - 23ma

| —s (O Partno DOZTIHD A
{IECEx PTB 12.0045

{Exia lIC T5..T4 Ga

| Ta= -50_+SATS/BSC

RTT80-T SIL

Foxboro; MA 02035, USA

by Bchnaldar Elsccric
IS, NI/ /Class | / Div. 1,2/ Group ABCD |

PTB 12 ATEX 2005
IMG Exin IlC TE/TST4 Ta= -50..+488080°C
112G Exa IC TE/TST4 Te= -50.. +SAFEE5C
§ Ui=30Y i< 130maA Ci=0 Li=D
& Install per MI 020-551

TE/T5T4 Ta=-50._+58/75/85°C
o | nstall per drawi 1E4Y A

Exia / NONING E CL1,GP. ABCD |
P Tem5m4 Ta- E0._sSeiTEESC i
.. _Install perdrawing KOTB4YC |

C

Dizplay connection

SN KON ® HART Temperature Transmitier " E,
DevRev: 2 i | RTTBO-T
FW: 01.01.04 ' ' =

Foxboro; MA 02035, USA by Sehnaider Elsctric
IS, Ml / [Class | / Div. 1,2 ! Group ABCD |

PTB 12 ATEX 2005 TE/T5/T4 Ta = -50_+58/7S/B5°C
@ 110 Exla IC TB/TST4 Te= -50..+488000°C ™ Install per drawing KOTE4YA H
112G Exia G TBITST4 Ta= -50..+58/7585°C Exia/ NONINCENDIVE CI. I, GP. ABCD |
g Ui=30Y i€ 130mA Ci=0 Li=D @ TET5/T4 Ta = -50..+5B/75/85°C i
o InstallperMIDIOSET % nstallperdrawingKO1S4YC |

Input; 11-30V e
Made in Germany 2014
Current consum.: 23mA
Part.no. DO271HD_A

{IECEx PTH 12,0045
{ExiallC T5..T4 Ga

e e

C

Figure 2. Typical Identification Labels for Dual Compartment Housing

Dual Compartment Housing IECEX Label

Codes CC, DD, EE, FF, GG, HH Tes® R T
(Codes ’ ’ L ’ 5| /A Series® TEMPERATURE TRANSMITTER R ST SR
>|MODEL STYLE ORIGIN ‘SEE CERTIFICATES FOR ELECTRICAL DATA
DONOTOPEN REF. No. SERIAL NO. SUPPLY | o[ EeErETLEcEnO.
'WHEN ENERGIZED g RANGE CAUTION: CABLE ENTRIES ivensys IECEX FMG 14.0005X; IP 66/67
2|CusT. DATA Ex |a‘IIE:T§ Y‘aG’L'!"a(. :njc 'f";c)v
C€E & [Waman 3 peavirreo womcm reweEmsrusE of peto wine sua o o1 A | FAL] [ ace st nsoce oo

FM Label

3 n
¢ .| 1A Series® TEMPERATURE TRANSMITTER B Cor
5 9 4 IC;T5Ta = 40°C fo 480°C;T6 40°C 047
¢ <luooe STYLE ORIGIN L1201 A1 T = 40 0 80 T8 4010 470
< IscL1on 1,6 i1
O & £[REF.NO. SERIAL NO. SUPPLY lTeT 0t e @ KotessT
seanorneauneo | 2| RANGE CAUTION: CABLE ENTRIES ToTa=40Co 455°;lnstllPe Draing KOIBAA |
% %lcust oama Foxboro [ _waiovaceascom:socuse
2 S|cusT. — LTS - 40C lo TGI8 Ta=-H0C1a 55C,
> | WARNING - THE PERMITTED WORKING TEMPERATURE OF FIELD WIRING SHALL BE AT ™ Schnelder €cccr Install Per Drawing KO164YA
5 [T e TR AWBIENT TEMPEAAT URE OF THE APPLICATION NCREASED BY 5°C Type 4X / 1PGSI6T

Data Label

12

< I/A Serles ® TEMPERATURE TRANSMITTER

2 2| mopeL sE ORIGIN

53 DoreTRA.
¢ 5| rer.No. SERIAL NO. SUPPLY

¢ &
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Standard Specifications

Ambient Temperature Limits
-40 and +85°C (-40 and +185°F)

— NOTE
To help ensure proper operation, do not exceed the ambient temperature limits at the
housing. This is particularly relevant when sensors/thermowells are directly connected
to the housing and very high process temperatures are being measured. The transfer of
heat from the process to the housing can be minimized by use of thermowell
extensions, or in extreme cases, by using a remote housing installation.

Supply Voltage Limits

11 and 42 V dc in Normal mode
11 and 32 V dc in SIL mode
Vmax = 30 V dc when certified as intrinsically safe.

Vibration Limits

¢ Basic Transmitter Module, Housing and Sensor Mounting Code BB: 25 to 100 Hz
for 4 “g” per GL-guidelines, Chapter 2, 2003 Edition.

¢ RTT80 Housing and Sensor Mounting Codes CC, EE, GG, J], NN, QQ: 19 mm
(0.75 in) double amplitude from 5 to 9 Hz, 0 to 30 m/s% (0 to 3 “g”) from 9 to
500 Hz

¢ RTT80 Housing and Sensor Mounting Codes DD, FF, HH, KK, PP, RR: 10 m/s
(1 “g”) maximum.
Type of Input

It is possible to connect two sensor inputs which are independent of each other. These are not
galvanically isolated from each other.

13
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Table 2. Input Types, Range Limits, Minimum Span (RTD or £2)

1. Introduction

» With 2-wire circu

it, compensation of wire resistance possible (0 to 30 Q)

Resistance
Thermometer
(RTD) as Per Standard Designation a Measuring Range Limits Min Span
IEC 60751:2008 Pt100 (1)
-200 to +850°C (-328 to +1562°F)
Pt200 (2)
0.003851 10 K (18°F)
Pt500 (3) -200 to +500°C (-328 to +932°F)
Pt1000 (4) -200 to +250°C (-328 to +482°F)
JIS C1604:1984 Pt100 (5) 0.003916 -200 to +510°C (-328 to +950°F) 10 K (18°F)
DIN 43760 IPTS-68 Ni100 (6)
- 0.006180 -60 to +250°C (-76 to +482°F) 10 K (18°F)
Ni120 (7)
GOST 6651-94 Pt50 (8) -185 to +1100°C (-301 to +2012°F)
0.003910 10 K (18°F)
Pt100 (9) -200 to +850°C (-328 to +1562°F)
OIML R84: 2003, Cu50 (10)
GOST 6651-2009 0.004280 -180 to +200°C (-292 to +392°F)
Cu100 (11)
: 10 K (18°F)
Ni100 (12)
- 0.006170 -60 to +180°C (-76 to +356°F)
Ni120 (13)
OIML R84: 2003, o o °
GOST 6651-94 Cu50 (14) 0.004260 -50 to +200°C (-58 to +392°F) 10 K (18°F)
- Pt100 (gallendar- The measuring range limits are
van Dusen) ) specified by entering the 10K (18°F)
Nickel Polynomial limit values that depend on the
Copper Polynomial coefficients A to C and RO.
» Type of connection: 2-wire, 3-wire or 4-wire connection, sensor current: < 0.3 mA

» With 3-wire and 4-wire connection, sensor wire resistance up to max. 50 Q per wire

Resistance Transmitter

Resistance Q

10 and 400 Q

10 and 2000 O

10Q

14
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MI 020-585 — November 2022

Table 3. Input Types, Range Limits, Minimum Span (TC or mV)

Configurable Measuring Range Limits

TCs as Per Recommended Temperature Min
Standard Designation Range Span
IEC 60584, Type A o o ° °
Part 1 (W5Re-W20Re)(30) 0 to +2500°C (+32 to +4532°F) 0 to +2500°C (+32 to +4532°F)
Type B o o +100 to +1500°C (+212 to
(PtRh30-PtRh6)(31) +40 to +1820°C (+104 to +3308°F) +2732°F)
Type E (NiCr-CuNi) (34) |-270 to +1000°C (-454 to +1832°F) | 0 to +750°C (+32 to +1382°F)
Type J (Fe-CuNi) (35) |-210 to +1200°C (-346 to +2192°F) | +20 to +700°C (+68 to +1292°F) | 50 K
Type K (NiCr-Ni) (36) | 270 to +1372°C (-454 to +2501°F) (90°F)
pppea—— 0 to +1100°C (+32 to +2012°F)
Type N (NiCrSi-NiSi) (37)|-270 to +1300°C (-454 to +2372°F)
Type R (PtRh13-Pt) (38)
-50 to +1768°C (-58 to +3214°F) | 0to +1400°C (+32 to +2552°F)
Type S (PtRh10-Pt) (39)
Type T (Cu-CuNi) (40) | -260 to +400°C (-436 to +752°F) | -185 to +350°C (-301 to +662°F)
IEC 60584,
Part 1; Type C (W5Re-W26Re) o o o o 50 K
ASTM (32) 0 to +2315°C (+32 to +4199°F) 0 to +2000°C (+32 to +3632°F) (90°F)
E988-96
ASTM Type D (W3Re-W25Re) o o o o 50 K
£988-96 (33) 0 to +2315°C (+32 to +4199°F) 0 to +2000°C (+32 to +3632°F) (90°F)
DIN 43710 | Type L (Fe-CuNi) (41) | -200 to +900°C (-328 to +1652°F) | 0 to +750°C (+32 to +1382°F) | 50 K
Type U (Cu-CuNi) (42) | -200 to +600°C (-328 to +1112°F) | -185 to +400°C (-301 to +752°F) | (90°F)
GOST . .
. . Type L (NiCr-CuNi) (43) -200 to o o 50 K
R8.8585- Type L (NiCr-CuNi) (43 o o 0 to +750°C (+32 to +1382°F o
2001 ype L ( ) (43) +800°C (-328 to +1472°F) ( ) | (90°F)
» Internal cold junction (Pt100)
» External cold junction: configurable value -40 to +85°C (-40 to +185°F)
» Max. sensor resistance k10 kQ (if sensor resistance is greater than 10 kQ, an error message as per
NAMUR NE89 is output)
Voltage
Transmitter | Millivolt Transmitter (mV) -20 to 100 mV 5mV
(mV)

15
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Maximum Measured Error and Repeatability

According to DIN EN 60770. The data concerning the various measured errors are typical
values and correspond to a standard deviation of +2 s (Gaussian normal distribution). Overall
measured error of the device at current output = digital measured error + measured error D/A.

See Table 4 and Table 5.

Table 4. Maximum Measured Error and Repeatability (RTD or £2)

Resistance Measured Error (+) Repeatability (z)
Thermometer (RTD) Measuring Range
According to Standard| Designation Limits Digital (a) D/A (b) Digital (a) D/A (c)
IEC 60751:2008 <0.14K o
Pt100 (1) 00 fo +850°C (0.25°F) <0.05 K (0.09°F)
-328 to +1562°F
P00 @) | ¢ ) ?105;2?;)( <0.13K (0.23°F)
-200 to +500°C <0.30K o
Pt500 (3) (-328 to +932°F) (0.54°F) < 0.08 K (0.14°F)
-200 to +250°C <0.14K R
Pt1000 (4) (-328 to +482°F) (0.25°F) < 0.05 K (0.09°F)
JIS C1604:1984 -200 to +510°C <0.12K o
Pt100 (5) (-328 to +950°F) (0.22°F) <.0.04 K (0.07°F)
DIN 43760 IPTS-68 . <0.09K
Ni100 (6 e
(©) -60 to +250°C (0.16°F) .
o < 0.03 K (0.05°F)
) (-76 to +482°F) <0.07K
Ni120 (7) o
(0.13°F) 0.01 %
GOS 5 0.03 % ( ' 2 1A)
T -185 to +1100°C <0.30K o 220
P50 (8) | (301 to+2012°F) | (0.54°F) < 0.05K(0.09°F)
-200 to +850 °C <0.14K o
Pt100 (9) (-328 to +1562°F) (0.25°F) < 0.07 K (0.13°F)
OIML R84: 2003, <0.19K o
GOST 6651-2009 Cus0 (10) | o0 oooc | (0.34°F) < 0.04 K (0.07°F)
-292 to +392°F
cutoo (11) | ¢ ) fooigi?g <0.03K (0.05°F)
Ni100 (12) -60 to +180°C <0.09K .
NH20 (13) | (7610+4356°F) | (0.16°F) <0.07K(0.13°F)
OIML R84: 2003, Cu50 (14) -50 to +200°C <0.19K 15 mQ
GOST 6651-94 (-58 to +392°F) (0.34°F) <200 mQ
Resistance . 10 to 400 Q 40 Q 15 mQ
transmitters Resistance O 10 to 2000 QO 500 Q <200 mQ

a. Using HART® transmitted measured value.

b. Percentage data refer to the configured span of the analog output signal.
c. Percentage data refer to the current range of the analog output signal (20 mA).
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Table 5. Maximum Measured Error and Repeatability (TC or mV)

Thermocouples

Measured Error (+)

Repeatability (+)

(TC) According to Measuring Range
Standard Designation Limits (a) Digital (b) D/A (c) Digital (b) D/A (d)
EC OB PR | Tio0R) (30) | (132104 4532F) | (292F) <0.52K (0.94°F)
VNt (31) | (1982 0 +a308°F) | (364) < 067K (121°F)
(NiCPépueNliE) (34) (j,g o ﬂgg(z)zg) ?o?é%lg < 0.07 K(0.13°F)
(Fe-EyL?Neif](SS) -40 to +1200°C ?0(-)427§F|§ = 0.08K(0.14°F)
(Nig)rt?\lﬁ)§36) cavto a1 ?o(.)é%%é = 0.1 K(0.20°F)
Typﬁigi)('(\jsi%rSi- (:jg o :123322% %97-?03':*; <016 K (0.29°F)
TypePI?) ((ztBR)ms- 0 to +1768°C ?3?4%%;() =076 K(137°F)
TypeP% ((ZBR)MO' (+32 1o +3214°F) (3_1'20',5) 0.03% | <0.74K (1.33°F) (Z'Zrﬁ)
(Cu-lgl? ﬁi)T(40) (-1(0) o 1‘;2222) fo?é%gg =0.11K (0.20°F)
ESC':I' I(\Sﬂoggdéé?gg " TWS6CI:?£\;V(?3F2{$- 0 to +2000°C ?1052§FI§ < 0.33 K(0.59°F)
ASTM E988-96 TWSS% ((a\)/v(eéz;a (+32 to +3632°F) ?1.12.;%?;; < 0.41 K (0.74°F)
I N e <007K 013%)
A e 010K 018
ggsssgss-zom (NiCr-!—é%?\lli_) (43) (-9?205 tt::18£?7020°cl:=) ?4?6§ZFI§ =< 0.15K(0.27°F)
xz:zgrjifiﬂers transNrLiligt\:a?'lt(mV) -20 o 100 mV ouv 4wy

a. Ranges over which stated Error and Repeatability apply. Input may be configured to wider range. See Table 3.
b. Using HART® transmitted measured value.

c. Percentage data refer to the configured span of the analog output signal.

d. Percentage data refer to the current range of the analog output signal (20 mA).
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Housing Specifications

1. Introduction

QQ |Low copper aluminum
alloy; epoxy coated
RR Stainless steel

With integral sensor and
thermowell

For surface or pipe mounting,
remote sensor (c)

For surface or pipe mounting,
remote sensor (c)

Explosion- Field Wiring
Housing Material and IEC/NEMA | proof and Mounting Entrances on
Code Finish Rating Flameproof Configuration Housing
Basic Module
BB Encapsulated plastic Basic Transmitter Module (b)
P20 (a) No (DIN Form B package) None
Dual Compartment Housing (c)

CC Low copper aluminum With integral bare sensor

alloy; epoxy coated
DD Stainless steel With integral bare sensor
EE Low copper aluminum With integral sensor and

alloy; epoxy coated thermowell
FF  |Stainless steel With integral sensor and M20

thermowell

GG Low copper aluminum For surface or pipe mounting,

alloy; epoxy coated remote sensor (C)
HH Stainless steel For surface or pipe mounting,

IP66/67 remote sensor (C)
- Yes —

JJ  |Low copper aluminum | NEMA 4X With integral bare sensor

alloy; epoxy coated
KK Stainless steel With integral bare sensor
NN Low copper aluminum With integral sensor and

alloy; epoxy coated thermowell
PP Stainless steel 1/2 NPT

18

using a clip (Option -D1).

. The basic module, although encapsulated, has exposed terminals not protected from the environment.
. The basic module is typically used for replacement and spares purposes; it can also be mounted to a surface or to a DIN rail

difference between housing compartments when thermocouples are used.

. Differential heating of the dual compartment housing may result in offset of primary value equivalent to the temperature

A WARNING

RISK OF IMPROPER INSTALLATION

For all RTT80-T Transmitters with an aluminum housing:

Failure to follow these instructions can result in death or serious injury.

When used in a potentially explosive atmosphere requiring apparatus of equipment category 1
G, the transmitter must be installed so that, even in the event of rare instances, an ignition
source due to impact or friction between the enclosure and iron/steel is excluded. This shall be
considered during installation, particularly if the equipment is installed in a zone 0 location.
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HART Communication Protocol

Protocol Revision: 7
Communication Rate: 1200 baud

Communication Distance:
Analog Mode: 3050 m (10,000 ft)
Multidrop Mode: 1525 m (5,000 ft)

Electrical Certification

The electrical certification is printed on the agency label which is located on the basic module and
on the transmitter housing (if applicable). The Electrical Safety Design Code is also included as
part of the model code on the data label which is located on the basic module or on the
transmitter housing (if applicable). See Figure 1 and Figure 2 for examples of typical agency and
data labels. For a complete explanation of the model code, see PL 008-680.

Electrical Specifications

These transmitters have been designed to meet the electrical safety descriptions listed in Table 6.
For detailed information or status of testing laboratory approvals/certifications, contact Global
Customer Support.

Table 6. Electrical Specifications

Testing Laboratory, Type of Protection, and Area Classification Model Code Option
Non-hazardous area 7z
CSAIIS, 1/1+2/ABCD (a) CA
CSA NI, 1/2/ABCD (a) CN
CSA Explosionproof, Class I, Division 1, BCD; CD

Dust-ignitionproof, Class Il, Division 1, EFG, Class lll, Division 1.
Also zone certified, Cl I, Zone 1, EX d IIC (a) (b)

ATEX Il 1G Ex ia [IC T4/T5/T6 (c) AA

IECEx Ex ia IIC T4/T5/T6 EA

IECEx Ex d T6 Gb Ta = -40°C to 70°C ED
Ex tb T85C Db (b)

FM IS, 1/1+2/ABCD FA

FM NI, I/2/ABCD FN

FM Explosionproof, Class I, Division 1, Groups B, C, and D; FD

Dust-ignitionproof, Class Il, Division 1, Groups E, F, and G, Class Ill Division 1

a. Not available with dual compartment housings.
b. Not available with the basic module (Housing and Sensor Mounting Code BB).
c. Available with Housing Code 'B' only.
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ATEX Compliance Documents

Directive 2014/34/EU Equipment or Protective Systems intended for use in potentially explosive
atmospheres.

Also, compliance with the essential health and safety requirements has been assured by
compliance with the following documents as stated in the compliance certificate:

PTB 12ATEX2006

II 2G Ex ia IIC T6..T4 Ga, T6; Ta (- 40°C to 55°C); T'5; Ta (-40°C to 70°C), T4;
Ta (-40°C to 85°C)
EN 60079-0:2009; EN 60079-11:2007

IECEx Compliance Documents

IECEx PTB 12.0045

Ex ia IIC T6..T4 Ga, T6; Ta(-50°C to 46°C)

T5; Ta(-50°C to 60°C), T4; Ta(-50°C to 60°C)

IEC 60079-0:2007-10 (edition 5); IEC 60079-11:2011 (edition 6); IEC 60079-26:2006
(edition 2)

IECEX FMG 14.0005X

Ex d IICT6 Gb Ta = -40°C to 70°C

Ex tb IIIC T85°C Db Ta = -40°C to 70°C

IEC 60079-0:2007-10 (edition 5); IEC 60079-1:2007 (edition 6); IEC 60079-31:2013
(edition 2)
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Warnings

A WARNING

EXPLOSION HAZARD
¢ Do not open while circuits are energized.
¢ Do not open when energized or when an explosive atmosphere may be present.
¢ Substitution of components may impair intrinsic safety or Division 2 approvals.

The certificate numbers have an X’ suffix which indicates that special conditions of
installation and use apply. Those installing or inspecting this equipment must have
access to the contents of the certificate or these instructions. The conditions listed in the
certificate are reproduced below.

¢ The main electronics enclosure is manufactured from an aluminum alloy,
and in rare cases is considered to present a potential risk of ignition by
impact or friction. Use caution and minimize the risk of impact or friction
when installing and using this product, particularly if the equipment is
installed in a Zone 0 location.

¢ When installed in flammable dust zones, under certain extreme
circumstances an incendive electrostatic charge may build up on the painted
surfaces, which are non-conducting. Therefore, the user/installer shall
implement precautions to prevent the build up of electrostatic charge, for
example, locate the equipment where a charge-generating mechanism (such
as wind-blown dust) is unlikely to be present and clean with a damp cloth.

¢ When installed in a flammable dust zone, the installer shall ensure that the
cable entry maintains the dust-tightness (IP6X) of the enclosure.

Failure to follow these instructions can result in death, serious injury or equipment damage.

For explosionproof certifications:

A WARNING

EXPLOSION HAZARD

¢ Keep cover tight while circuits are energized unless area is known to be
nonhazardous.

¢ To help prevent ignition of flammable or combustible atmospheres, disconnect
power before servicing.

Failure to follow these instructions can result in death or serious injury.
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2. Installation

The following material provides information and procedures for installing the RT'T80
Transmitter. For dimensional information, refer to DP 020-580.

Installation shall be carried out in accordance with the applicable code of practice (typically
IEC 60079-14) by suitably trained personnel.

There are no special checking or maintenance conditions. All explosion-protected equipment
should be periodically inspected in accordance with the applicable code of practice (typically
IEC 60079-17). The interval between inspections should not normally exceed 3 years, unless
justification for a longer interval is given.

With regard to explosion safety, it is not necessary to check for correct operation.

NOTICE

POTENTIAL REDUCED PERFORMANCE OR EQUIPMENT DAMAGE
¢ Use a suitable thread sealant on all connections.

¢ Do not use bare sensor or thermowell mounting to the 316 ss housing in high
vibration areas.

¢ The RTT80 is only certified for use in ambient temperatures marked on the
equipment and should not be used outside this range.

¢ The maximum process pressure indicated on the marking must not be exceeded.

¢ The maximum permitted ambient temperature of the RT'T80 temperature
transmitter is 85°C. To avoid the effects of process temperature and other thermal
effects, care shall be taken to ensure that the electronics housing temperature does
not exceed an ambient temperature of 85°C.

Failure to follow these instructions can result in reduced performance or equipment damage.

Mounting

The basic transmitter module can be mounted on a flat surface or on a DIN rail using a simple
clip. It is assumed that sufficient environmental protection is provided when a basic transmitter is
used without a housing.

The transmitter is also offered with a dual-compartment housing, which isolates and seals the
wiring terminals from the electronics compartment. The transmitter in a field housing can be
pipe mounted, surface mounted, mounted directly to a bare sensor, or thermowell mounted. See

Figure 3 through Figure 6.

For extremely high process temperatures, a remote mounted sensor is recommended. Also, the
mounting stability can influence how the sensor is attached to the transmitter. If the process vessel
is highly insulated and the thermowell has considerable lagging, a remote mounted transmitter
attached to a 50 mm (2 inch) pipe is recommended. When mounting the transmitter, take into
account the necessary room to remove the cover.

23
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Requirements

1.

For all versions, the sensor circuit is not infallibly galvanically isolated from the input
circuit. However, the galvanic isolation between the circuits is capable of withstanding
a test voltage of 500 Vac during 1minute.

For RTT80-T with dual compartment housing, be sure to use cable entries and
blanking elements that are suitable for the application and are correctly installed.

For all versions with an ambient temperature > 60°C, heat resistant cables with a
rating of at least 20 K above the ambient temperature must be used.

For Type RTT80-T with Housing and Sensor Mounting Code BB, the transmitter
must be mounted in an enclosure in order to provide a degree of ingress protection of
at least IP20.

For Type RTT80-T with Housing and Sensor Mounting Code BB, the transmitter
may only be installed in a potentially explosive atmosphere caused by the presence of
combustible dust when mounted in a metal enclosure according to DIN 43729 that is
providing a degree of protection of at least IP66/67 in accordance with EN 60529.

Basic Module Mounting Options

Figure 3. Basic Module Mounting Options (Housing and Sensor Mounting Code BB)

SURFACE OPTIONAL
MOUNTING
BUSHING
USER-SUPPLIED
MOUNTING SCREWS
(2 PLACES)

2. Installation



2. Installation MI 020-585 — November 2022

Dual Compartment Housing Mounting Options

Figure 4. Dual Compartment Housing Mounting Options: Remote Sensor (Housing and Sensor
Mounting Codes GG, HH, QQ, and RR)

CONDUIT
DN 50 OR CONNECTION
2nPIPE 8 (2 PLACES)

(BY USER)

AW AT AT a1
gilibilill

‘
i

>
1

qrgTave

({itili

HOUSING CODES
—

D GG = ALUMINUM M20 HOUSING
FOR REMOTE SENSOR
HH = 316 ss M20 HOUSING
FOR REMOTE SENSOR
QQ = ALUMINUM 1/2 NPT HOUSING
\\\ __///’ FOR REMOTE SENSOR
ggﬁ;ﬁgE___ RR = 316 ss 1/2 NPT HOUSING
FOR REMOTE SENSOR
MOUNTING  MOUNTING
SURFACE BRACKET
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Figure 5. Dual Compartment Housing Mounting Options: Integral Sensor (Housing and Sensor
Mounting Codes CC, DD, EE, FE JJ, KK, NN, and PP)

CONDUIT
‘/(CZOP'T_'XEC%TS')O N HOUSING CODES
CC = ALUMINUM M20 HOUSING
WITH BARE SENSOR
DD = 316 SS M20 HOUSING
WITH BARE SENSOR
EE = ALUMINUM M20 HOUSING WITH
SENSOR AND THERMOWELL
FF = 316 SS M20 HOUSING WITH
SENSOR AND THERMOWELL
JJ = ALUMINUM 1/2 NPT HOUSING
| WITH BARE SENSOR
= KK = 316 SS 1/2 NPT HOUSING
WITH BARE SENSOR
NN = ALUMINUM 1/2 NPT HOUSING
WITH SENSOR AND THERMOWELL
PP = 316 SS 1/2 NPT HOUSING
WITH SENSOR AND THERMOWELL

12 NPT

BARE SENSOR

SENSOR
AND
THERMOWELL SENSOR AND
THERMOWELL
WITH LAGGING

Thermowell Mounting

Figure 6. Thermowell Mounting (Dual Compartment Housing Shown)

LAGGING
PROCESS
C
THERMOWELL \
I|
/n\ ;l
INSULATION
FILLER
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Cover Locks

A cover lock is provided as standard with certain agency certifications and as part of the Custody
Transfer Lock and Seal option.

To lock the covers on the dual compartment housing:

1. Tighten each cover on the housing until the flange on the cover comes into contact
with the flange on the housing.

2. Tighten the locking screw as shown below and tighten the clamp screw.

3. Insert the seal wire through the clamp and crimp the seal if applicable.

Locking
Screw Lead

Your transmitter must be installed to meet all local installation regulations, such as hazardous
location requirements and electrical wiring codes. Persons involved in the installation must be

trained in these code requirements. To maintain agency certification, your transmitter must also
be installed in accordance with the agency requirements.

A WARNING

RISK OF MOISTURE INGRESS

To maintain IEC IP66/IP67 and NEMA Type 4X protection on transmitters with dual
compartment housings, plug any unused conduit opening with the metal plug provided. In
addition, the threaded housing cover must be installed. Hand-tighten the cover so that the
o-ring is fully captured, making sure that the flange of the cover comes into contact with the

flange of the housing,.

It is recommended that you use transient/surge protection in installations prone to high levels of
electrical transients and surges.

Failure to follow these instructions can result in serious injury or equipment damage.
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Input Connections

There are seven terminals on the basic module for input and output connections. Terminals 1 and
2 are for bus power and measurement output and terminals 3 through 7 are for RTD, TC, ohm,
or mV sensor inputs. See Figure 8.

In the dual-compartment housing with remote sensor, the bus and sensor connections are made
through the terminal block in the customer connection side of the housing. The terminals are
identified with the same numbers as the module connections and the wires are color-coded as
indicated in Figure 9.

Figure 8. Input Connections on the Basic Module

Sensor input 2 Sensor input 1 Bus connection
. and supply voltage
RTD, Q 3- and 2-wire red RTD, Q 4-, 3- and 2-wire
C * (black) T 3
e 1o re —o—o —eo - red "
(black)! - N
TC, m + ey 1—e
—e - —e o o red +
ﬂ ﬁ\ {J {} TC, mvﬂ \ \ {
ol —o ° Lo ° e White
white ° white 3. 2
(yellow)

Display connection
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Figure 9. Dual Compartment Housing Wiring from the Terminal Block to the Module

Display connection
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The following connection combinations are possible when both sensor inputs are assigned:

Sensor Input 1
RTD or RTD or RTD or
Resistance Resistance Resistance Thermocouple (TC),
Transmitter, Transmitter, Transmitter, Voltage
Sensor Input 2 2-Wire 3-Wire 4-Wire Transmitter

RTD or Resistance
Transmitter, 2-Wire OK OK T OK
RTD or Resistance
Transmitter, 3-Wire OK OK (a) _ OK (a)
RTD or Resistance _ _ _ _
Transmitter, 4-Wire
Thermocouple (TC),
Voltage Transmitter OK OK (a) OK (a) OK (a)

a. These wiring types are permitted in SIL mode.

Loop Wiring
When wiring the transmitter, the supply voltage and loop load must be within specified limits.
The supply output load vs. voltage relationship is:

Ry max = (Up max — 11V) /0.023 A (current output) and is shown in Figure 10.

Any combination of supply voltage and loop load resistance in the shaded area can be used. To
determine the loop load resistance (transmitter output load), add the series resistance of each
component in the loop, excluding the transmitter. The power supply must be capable of
supplying 23 mA of loop current.

— NOTE

The maximum voltage is 30 V dc for transmitters certified as intrinsically safe.

Figure 10. Supply Voltage and Loop Load

1348

€ 1098

<

o

kel

[3)

o

-

3 250

=]

o 0 = Up
11V 16.75V 36.25V 42V
Supply Voltage (V dc)

— NOTE

The transmitter will function with an output load less than 250 Q provided that a
HART Communicator or PC-based Configurator is not connected to it. Use of a
HART Communicator or PC-based Configurator requires 250 Q minimum load.
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To wire one or more transmitters to a power supply, proceed with the following steps:
1. Remove the cover from the transmitter field terminals compartment.

2. Run signal wires (0.50 mm? or 20 AWG, typical) to the transmitter. Use twisted
single pair to protect the 4 to 20 mA output and/or remote communications from
electrical noise. Maximum recommended length for signal wires is:

¢ 3050 m (10,000 ft) using single pair cable and adhering to requirements of
HART physical layer implementation defined in HART Document HCF_SPEC-
53. Use CN=1 when calculating maximum lengths.

¢ 1525 m (5000 ft) in a multidrop (15 devices maximum) mode.
Screened (shielded) cable could be required in some locations.

— NOTE

Do not run transmitter wires in same conduit as mains (ac power) wires.

3. If shielded cable is used, earth (ground) the shield at the power supply only. Do not
ground the shield at the transmitter.

4. If housing is used, plug any unused conduit connection with a metal plug.

5. Connect an earth (ground) wire to the earth terminal in accordance with local
practice.

NOTICE
POTENTIAL REDUCED PERFORMANCE OR EQUIPMENT DAMAGE

If the signal circuit must be earthed (grounded), it is preferable to do so at the negative
terminal of the dc power supply. To avoid errors resulting from earth loops or the

possibility of short-circuiting groups of instruments in a loop, there should be only one
earth in a loop.

Failure to follow these instructions can result in reduced performance or equipment
damage.

6. Connect receivers (such as controllers, recorders, indicators) in series with power
supply and transmitter as shown in Figure 11.

7. If a housing is used, install the cover onto the housing.

8. If wiring additional transmitters to the same power supply, repeat Steps 1 through 7
for each additional transmitter. The setup with multiple transmitters connected to a
single power supply is shown in Figure 12.

9. The HART Communicator can be connected in the loop between the transmitter and
the power supply as shown in the two figures below. Note that a minimum of 250 Q
must separate the power supply from the HART Communicator.
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Figure 11. Transmitter Loop Wiring

250 Q MINIMUM7

VMV

INDICATOR

SUPPLY]

+ -

HART ~ 4
HAND-HELD !
TERMINAL,

OR PC-BASED
CONFIGURATOR

CONTROLLER
OR RECORDER

Figure 12. Wiring Several Transmitters to a Common Power Supply

—
1

1| POWER
SUPPLY
I
250 Q
min.® min.@
+ _ + _ + _
TRANSMITTER TRANSMITTER TRANSMITTER

(a) 250 Q MINIMUM LOAD (INCLUDING RESISTANCE OF OTHER INSTRUMENTS)
IN EACH LOOP IS REQUIRED WHEN USING A HART COMMUNICATOR.

-\ (b) CONNECT HART COMMUNICATOR BETWEEN TRANSMITTER AND ITS

ASSOCIATED INSTRUMENTS AS SHOWN.

HART COMMUNICATOR® I__l_l_u
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Multidrop Communication

“Multidropping” refers to the connection of several transmitters to a single communications
transmission line. Communications between the host computer and the transmitters takes place
digitally with the analog output of the transmitter deactivated. With the HART communications
protocol, up to 15 transmitters can be connected on a single twisted pair of wires or over leased
telephone lines.

The application of a multidrop installation requires consideration of the update rate necessary
from each transmitter, the combination of transmitter models, and the length of the transmission
line. Multidrop installations are not recommended where Intrinsic Safety is a requirement.
Communication with the transmitters can be accomplished with any HART compatible modem
and a host implementing the HART protocol. Each transmitter is identified by a unique address
(1-15) and responds to the commands defined in the HART protocol.

Figure 13 shows a typical multidrop network. Do not use this figure as an installation diagram.
Contact the HART Communications Foundation, visit http://www.hartcomm.org/, with specific
requirements for multidrop applications.

Figure 13. Typical Multidrop Network

HOST MODEM
LOAD
POWER
SUPPLY RTT80-T, RTT80- RTT80-




3. Operation

The RTT80 is operated as a HART compliant device. Measurement may be communicated either
as point-to-point or as a multi-drop transmitter. Output may be digital using HART commands
or primary value via 4 to 20 mA output.

Operation via HART 7 Protocol

With the exception of two operations that can be carried out by means of the Display DIP
switches described below, the RT'T80-T is operated via HART revision 7 protocol. Operation via
the HART protocol can be done using a handheld HART Field Communicator, models 375 or
475, or a PC-based configurator. See Chapter 4 for details of the on-line menu accessible by
means of the HART communicator.

HART Commands

Information is transferred between a HART Master, such as the handheld or PC-based
configurator, and the RT'T80 by means of HART commands.

There are three different types of commands:

¢ Universal commands: All HART® devices support and use universal commands.
These are associated with the following functionalities for example:

¢ Recognition of HART® devices
¢ Reading digital measured values

¢ Common practice commands: Common practice commands offer functions which
are supported and can be executed by many but not all field devices.

¢ Device-specific commands: These commands allow access to device-specific functions
which are not HART® standard. Such commands access individual field device
information, among other things.

Table 7. HART Commands

Command No. Designator
Universal commands
0, Cmd0 Read unique identifier
1, Cmd001 Read primary variable
2, Cmd002 Read loop current and percent of range
3, Cmdo03 Read dynamic variables and loop current
6, Cmd006 Write polling address
7, Cmd007 Read loop configuration
8, Cmd008 Read dynamic variable classifications
9, Cmd009 Read device variables with status
11, CmdoO11 Read unique identifier associated with TAG
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Table 7. HART Commands (Continued)

3. Operation

Command No. Designator

12, Cmd012 Read message

13, Cmdo013 Read TAG, descriptor, date

14, Cmd014 Read primary variable transducer information
15, Cmd015 Read device information

16, Cmdo016 Read final assembly number

17, Cmd017 Write message

18, Cmd018 Write TAG, descriptor, date

19, Cmdo019 Write final assembly number

20, Cmd020 Read long TAG (32-byte TAG)

21, Cmdo021 Read unique identifier associated with long TAG
22, Cmd022 Write long TAG (32-byte TAG)

38, Cmd038 Reset configuration changed flag

48, Cmd048 Read additional device status

Common practice commands

33, Cmd033 Read device variables

34, Cmd034 Write primary variable damping value
35, Cmd035 Write primary variable range values
36, Cmd036 Set primary variable upper range value
37, Cmd037 Set primary variable lower range value
40, Cmd040 Enter/Exit fixed current mode

42, Cmd042 Perform device reset

44, Cmd044 Write primary variable units

45, Cmd045 Trim loop current zero

46, Cmd046 Trim loop current gain

50, Cmd050 Read dynamic variable assignments
51, Cmd051 Write dynamic variable assignments
54, Cmd054 Read device variable information

59, Cmd059 Write number of response preambles
103, Cmd103 Write burst period

104, Cmd104 Write burst trigger

105, Cmd105 Read burst mode configuration

107, Cmd107 Write burst device variables

108, Cmd108 Write burst mode command number
109, Cmd109 Burst mode control

HART Communicator and Device Descriptor (DD)

For proper operation with a HART communicator, it must contain the proper DD (Device
Descriptor) file for the RT'T80-T. The DD is available from any authorized HART Foundation

source and is compatible with both the SIL and non-SIL versions of the RT'T80.
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PC-Based Device Type Manager (DTM)

A PC-based DTM (Device Type Manager) for the RTT80 is described in Chapter 4, “Operating
Menu and Parameter Description”. The HART 7 RTT80 DTM is compatible with both the SIL
and non-SIL versions of the RT'T80. Examples of screenshots from the D'TM can be found
throughout Chapter 4, “Operating Menu and Parameter Description”.

Operation via Optional -L1 Display

Two features of the RTT80 are configured via hardware in the form of DIP switches on the
optional -L1 Display. The Disp 180 DIP switch toggles the display orientation 180 degrees. The
WRITE LOCK DIP switch locks all settings in the RT'T80 and they remain locked even if the
display is removed. If removed, the display must be re-connected in order to unlock the RT'T80.

All other DIP switches are inactive when used with the RTTS80-T.

Figure 14. Display DIP Switches
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m
m
[mm)

Lo

1 Connector to RTT80 transmitter
2 DIP switches 1 through 64, HW/SW, ADDR ACTIVE, SIM — Factory use only
3 WRITE LOCK, DISP 180° - Set to ON/OFF
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4. Operating Menu and Parameter
Description

The following tables list the parameters in the Setup, Diagnostics, and Expert operating
menus. The page reference indicates where a description of the parameter can be found in the
manual.

Screenshots from the RT'T80 HART 7 DTM are provided to help you navigate through the

configuration process.

In Figure 15, the Upper range value is being changed to 100.00. When a parameter is
changed in the DTM, a pencil icon appears, which prompts to press the Enter key.

Figure 15. Upper Range Value

%° RTT80V1.01zz/ Dev.Rev 2 # Online parameterization 4 x
Device name: RTTE0 Output current: S 11.73 mA F b
é;‘} Device tag: WaterTank [4'H @ 24.15 =C
) by Schneider Electric
- ] p : i
Status signak ﬂ oK Device temperature: 27.09 =C
@ DB | [Restore M& %00
|'Menu | variable |i| Device tag: WaterTank
é---PJ Access status tooling: Uniit: (32) =C [v]
EHZ  setwp —
PC1 Device tag: Sensor type 1: (12) Pt100 IEC60751, a=0.00385 (1) [v|
~P Unit: _ Connection type 1: (3) 3- wire |E|
--PC1 Sensor type 1t —
) . r type 2: ,a=0.
P Connection type 1: Sensor type 2 (12) Pt100 IEC60751, a=0.00385 (1) [v|
~PC1 Sensor type 2: Connection type 2: (3) 3- wire [¥]
--P1  Connection type 2: a 5 = DA |_|
3 Assign current output (PV): ssign current output (PV) (3) Average &4
P Lower range value: Lower range value: 0,00 =C
o T ||
i Upper range value: / ’ ID:J.DD o
[+  Advanced setup
[+  Diagnostics
[EHiZr  Expert
P Enter access code:

Depending on the parameter configuration, not all submenus and parameters are available in
every device. Information on this can be found in the parameter description under
Prerequisite. The parameter groups for the Expert setup contain all the parameters of the
Setup and Diagnostics operating menus, as well as other parameters that are solely reserved
for experts.

Configuration in the SIL mode differs from the standard mode and is described in the Functional
Safety Manual.

For more information refer to the Functional Safety Manual MI 020-584. Click the white-on-red
question mark icon in Figure 15 to open a copy of the MI document.
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Table 8. Setup Menu

Setup > Device tag See page 43
Unit See page 43

Sensor type 1 See page 43

Connection type 1 See page 43

2-wire compensation 1 See page 44

Reference junction 1 See page 44

RJ preset value 1 See page 45

Sensor type 2 See page 43

Connection type 2 See page 43

2-wire compensation 2 See page 44

Reference junction 2 See page 44

RJ preset value 2 See page 45

Assign current output (PV) See page 45

Lower range value See page 46

Upper range value See page 46

Setup Advanced Setup Enter access code See page 48
Access status tooling See page 49

Locking status See page 49

Device temperature alarm See page 49

Setup > Advanced Setup > Sensor > Sensor offset 1 See page 49
Sensor offset 2 See page 49

Corrosion detection See page 50

Drift/difference mode See page 51

Drift/difference alarm category | See page 51

Drift/difference alarm delay See page 51

Drift/difference set point See page 51
Sensor switch set point See page 52
Setup > Advanced Setup > Current output > Output current See page 52
Measuring mode See page 53
Out of range category See page 53
Failure mode See page 53
Failure current See page 53
Current trimming 4 mA See page 54
Current trimming 20 mA See page 54
Setup > Advanced Setup > Display > Display interval See page 54
Format display See page 54
Value 1 display See page 56
Decimal places 1 See page 56
Value 2 display See page 56
Decimal places 2 See page 57
Value 3 display See page 57
Decimal places 3 See page 57
Setup > Advanced Setup > SIL > SIL option See page 69
Operational state See page 69
Enter SIL checksum See page 69
Timestamp SIL configuration |See page 70
SIL startup mode See page 70
SIL HART mode See page 70
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Table 8. Setup Menu (Continued)

Force safe state See page 70
Setup > Advanced Setup > Administration > Device reset See page 71

Define device write protection |See page 71
code

1able 9. Diagnostics Menu

Diagnostics |Actual diagnostics See page 72
Remedy information See page 72
Previous diagnostics 1 See page 73
Operating time See page 73
Diagnostics |Diagnostics list > Actual diagnostic count See page 73
Actual diagnostics See page 73
Actual diag channel See page 73
Diagnostics |Event logbook > Previous diagnostics n See page 74
Previous diag channel n See page 74
Diagnostics |Device information > |Device tag See page 74
Serial number See page 74
Firmware version See page 74
Device name See page 75
Order code See page 75
Configuration counter See page 75
Diagnostics |Measured values > Sensor value 1 See page 75
Sensor value 2 See page 75
Device temperature See page 75
Diagnostics |Measured values > Min/max values > Sensor n min value See page 76
Sensor n max value See page 76
Reset sensor min/mix See page 76
values

Device temperature min. |See page 76
Device temperature max. |See page 76
Reset device temperature |See page 77

min/max
Diagnostics |Simulation > Simulation current output See page 77
Value current output See page 77

Table 10. Expert Menu

Expert > |Enter access code See page 48
Access status See page 49
toolings
Locking status See page 49

Expert > |System > Unit See page 43

Damping See page 78
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Table 10. Expert Menu (Continued)

Alarm delay See page 78
Mains filter See page 78
Device temperature alarm See page 78
Expert > |System > Display > Display interval See page 54
Format display See page 54
Value 1 display See page 56
Decimal places 1 See page 56
Value 2 display See page 56
Decimal places 2 See page 57
Value 3 display See page 57
Decimal places 3 See page 57
Expert > |System > Administration > Device reset See page 71
Define device write See page 71
protection code
Expert > |Sensor > Sensor n (a)> Sensor type n See page 43
Connection type n See page 43
2-wire compensation n See page 44
Reference junction n See page 44
RJ preset value See page 45
Sensor offset n See page 49
Sensor n lower limit See page 79
Sensor n upper limit See page 78
Sensor serial number See page 79
Expert > |Sensor > Sensor n > Sensor trimming > Sensor trimming See page 80
Sensor trimming See page 80
lower value
Sensor trimming See page 81
upper value
Sensor trimming See page 81
min span
Expert > |System > Sensor n (a) > Linearization > Sensor n lower limit |See page 82
Sensor n upper limit | See page 82
Call./v. Dusen coeff. |See page 82
RO,A,BC
Polynomial coeff. See page 82
RO, A, B
Expert > [Sensor > Diagnostic settings > |Corrosion detection See page 50
Drift/difference mode See page 51
Drift/difference alarm See page 51
category
Drift/difference alarm See page 51
delay
Drift/difference set point See page 51
Sensor switch set point See page 52
Calibration counter start See page 83
Calibration alarm category See page 83
Calibration counter start See page 83
value
Calibration countdown See page 83
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Table 10. Expert Menu (Continued)

M1 020-585 — November 2022

Expert > |Output > Output current See page 52
Measuring mode See page 84
Lower range value See page 84
Upper range value See page 46
Out of range category See page 53
Failure mode See page 53
Failure current See page 53
Current trimming 4 mA See page 54
Current trimming 20 mA See page 54
Expert > |Communication [HART configuration I | Device tag See page 84
HART short tag See page 84
HART address See page 84
No of preambles See page 84
Configuration changed See page 84
Reset configuration See page 85
changed flag
Expert > |Communication [HART info > Device type See page 85
Device revision See page 85
HART revision See page 85
HART descriptor See page 85
HART message See page 85
Hardware revision See page 86
RevSW See page 86
HART date code See page 86
Expert > |Communication |[HART output > Assign current output See page 86
(PV)
PV See page 86
Assign SV See page 87
SV See page 87
Assign TV See page 87
TV See page 87
Assign QV See page 87
Qv See page 87
Expert > |Communication |Burst configuration > |Burst mode See page 88
Burst command See page 88
Burst variable 0-3 See page 89
Burst trigger mode See page 90
Burst trigger level See page 90
Burst min period See page 90
Burst max period See page 91
Expert > |Diagnostics > Actual diagnostics See page 72
Remedy information See page 72
Previous diagnostics 1 See page 73
Operating time See page 73
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Table 10. Expert Menu (Continued)

4. Operating Menu and Parameter Description

Expert > |Diagnostics > Diagnostics list > Actual diagnostics See page 73
count
Actual diagnostics See page 73
Actual diag channel See page 73
Expert > |Diagnostics > Event logbook > Previous diagnostics n See page 74
Previous diag channel See page 74
Expert > |Diagnostics > Device information > |Device tag See page 43
Serial number See page 74
Firmware version See page 74
Device name See page 75
Order code See page 75
Extended order code See page 91
Extended order code 2 Seepage 91
Extended order code 3 See page 91
ENP version See page 91
Device revision See page 91
Manufacturer ID See page 92
Manufacturer See page 92
Hardware revision See page 92
Configuration counter See page 75
Expert > |Diagnostics > Measured values > Sensor n value See page 75
Sensor n raw value See page 92
Device temperature See page 75
Expert > |Diagnostics > Measured values > Min/max values > Sensor n min value |See page 76
Sensor n max value |See page 76
Reset sensor See page 76
min/max values
Device temperature |See page 76
min.
Device temperature |See page 76
max.
Reset device See page 77
temperature
min/max
Expert > |Diagnostics > Simulation > Simulation current output See page 77
Value current output See page 77

a. n = number of sensor inputs (1 and 2)

Setup Menu

This menu contains all the parameters that are needed to configure the basic settings of the
device. The transmitter can be put into operation with this limited parameter set.

— NOTE

n = Stands for the number of sensor inputs (1 and 2)
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Device tag
Navigation Setup > Device tag
Diagnostics > Device information > Device tag
Expert > Diagnostics > Device information > Device tag
Description Use this function to enter a unique name for the measuring point so it can be
identified quickly within the plant. The name is displayed in the header of the
plug-in display.
User entry Max. 32 characters, such as letters, numbers or special characters (e.g. @, %, /)
Factory setting -none-
Unit
Navigation Setup > Unit
Expert > System > Unit
Description Use this function to select the engineering unit for all the measured values.
Options »°C
» °F
»K
» °R
» Ohm
»mV
Factory setting °C

Sensor type n

Navigation

Setup > Sensor type n
Expert > Sensor > Sensor n > Sensor type n

Description

Use this function to select the sensor type for the sensor input in question.
» Sensor type 1: settings for sensor input 1
» Sensor type 2: settings for sensor input 2
Note: Observe the terminal assignment when connecting the individual
sensors. In the case of 2-channel operation, the possible connection options
also have to be observed.

Options

A list of all the possible sensor types is provided in the ‘Technical data' section.

Factory setting

Sensor type 1: Pt100 IEC751
Sensor type 2: No sensor

Connection type n

Navigation

Setup > Connection type n
Expert > Sensor > Sensor n > Connection type n

Prerequisite

An RTD sensor must be specified as the sensor type.

Description

Use this function to select the connection type for the sensor.

Options

» Sensor 1 (connection type 1): 2-wire, 3-wire, 4-wire
» Sensor 2 (connection type 2): 2-wire, 3-wire

Factory setting

( ):
» Sensor 1 (connection type 1): 4-wire
» Sensor 2 (connection type 2): 2-wire

Note that in Figure 15, the sensor selection RTD serves as a “prerequisite” for the Connection
type parameter to be listed. In the Setup screen in Figure 16, where the prerequisite
thermocouple is selected, the relevant parameter Reference junction is listed instead.
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Figure 16. Prerequisite Thermocouple with Reference Junction Parameter

%° RTT80V1.01zz/ Dev.Rev 2 # Online parameterization 4 x
Device name: RTTE0 Output current: 8.26 mA F b
f;‘} Device tag: WaterTank PV: 79.95 °F
) by Schneider Electric
- ] p : !
Status signak ﬂ oK Device temperature: 80.62 °F
@ O] | Restore & %010 |
|'Menu | variable |i| Device tag: ’ WaterTank
P Access status tooling: Unit: (33) F |:|
CHig  Setup —
o Sensor type 1: (137) Type K (NiCr-Ni) IEC60584 (38)  [v|
P Unit Reference junction 1: (1) Internal measurement |E|
--PC1 Sensor type 1t - - —
.#01 Reference junction 1: Sensor type 2: (137) Type K (NiCr-i) IECE0584 (36) [+ |
P Sensor type 2: Reference junction 2: (1) Internal measurement |E|
P Reference junction 2: a 5 = DA |_|
P03 Assign current output (PV): ssign current output (PV) (3) Average &4
P Lower range value: Lower range value: 32.00| °F
P U lue:
i PREr range value Upper range value: 212,00 °F
[+  Advanced setup

2-wire compensation n

Navigation Setup > 2-wire compensation n
Expert > Sensor > Sensor n > 2-wire compensation n

Prerequisite An RTD sensor with a 2-wire connection type must be specified as the sensor
type.

Description Use this function to specify the resistance value for two-wire compensation in
RTDs.

Options 0 to 30 Ohm

Factory setting 0

Reference junction n

Navigation

Setup > Reference junction n
Expert > Sensor > Sensor n > Reference junction n

Prerequisite

A thermocouple (TC) sensor must be selected as the sensor type.

Description

Use this function to select reference junction measurement for temperature
compensation of thermocouples (TC).

NOTE:
» If Preset value is selected, the compensation value is specified via the RJ
preset value parameter.
» Temperature measured must be configured for channel 2 if Measured value
sensor 2 is selected.

Options

» No compensation: no temperature compensation is used.

» Internal measurement: the internal reference junction temperature is used.
» Preset value: a fixed preset value is used.

» Measured value sensor 2: the measured value of sensor 2 is used.

NOTE: It is not possible to selected the Measured value sensor 2 option for the
Reference junction 2 parameter.

Factory setting

Internal measurement
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RJ preset value n

Navigation

Setup > RJ preset n
Expert > Sensor > Sensor n > RJ preset n

Prerequisite

The Preset value parameter must be set if the Reference junction n option is
selected.

Description

Use this function to define the fixed preset value for temperature compensation.

User entry

-50 to +85 °C

Factory setting

0.00

Assign current output (PV)

Navigation

Setup > Assign current output (PV)
Expert > Communication > HART output > Assign current output (PV)

Description Use this function to assign a measured variable to the primary HART® value
(PV).
Options » Sensor 1 (measured value)

» Sensor 2 (measured value)

» Average of the two measured values: 0.5 x (SV1+SV2)

» Difference between sensor 1 and sensor 2: SV1-SV2

» Sensor 1 (backup sensor 2): If sensor 1 fails, the value of sensor 2
automatically becomes the primary HART value (PV): sensor 1 (OR sensor
2)

» Sensor switching: If the value exceeds the configured threshold value T for
sensor 1, the measured value of sensor 2 becomes the primary HART®
value (PV). The system switches back to sensor 1 if the measured value of
sensor 1 is at least 2 K below T: sensor 1 (sensor 2, if sensor 1 > T).

» Average: 0.5 x (SV1+SV2) with backup (measured value of sensor 1 or
sensor 2 in the event of a sensor error in the other sensor)

Note: The threshold value can be set with the Sensor switching limit value
parameter (see page 52). With temperature-dependent switching, it is
possible to combine 2 sensors that offer advantages in different temperature
ranges.

Factory setting

Sensor 1
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Figure 17 shows the assignment of Current output (PV). Because the system is configured for two
sensors, selections for Average, Difference, and Sensor switching are offered.

Figure 17. Assignment of Current Output (PV)

%° RTT80V1.01zz/ Dev.Rev 2 # Online parameterization 4 x
Device name: RTTE0 Output current: 7.85 mA F0 bo 0
{;t‘ Device tag: WaterTank PV: 24,10 =C
) @E by Schneider Electric
. . p 1 .
Status signalk ' oK Device temperature: 26.09 =C
@ DAIE]| restore &+ 00 |
|'Menu | variable |i| Device tag: WaterTank
|:'1_? RTT80 Unit: (33 =C [
P Access status tooling: —
B  Setwp Sensor type 1: (12) Pt100 IEC60751, a=0.00385 (1) [v|
~P Device tag: Connection type 1: (3) 3- wire |E|
| Unit: —
o1 Sensor type ©: Sensor type 2: (12) Pt100 [EC60751, a=0.00385 (1)  [v]
-p1  Connection type 1: Connection type 2: (3) 3- wire El
~-PC1 Sensor type 2t E —
B ) 3 Assign current output (PV): P [ (0) sensor 1 [
--P1  Connection type 2: =
e B /\ccign current output (PV): Lower range value: o€’
_ 1) Sensor 2
P Low lue: (
OUET range vaue Upper range value: (2) Device temperature °C
P Upper range value: 3 A =
[EHir  Advanced setup E4; D:age
ifference
Ente de:
NLer access o EI' (5) Sensor 1 (Backup Sensor 2)
Access status tooling: (6) Sensor switching
Locking status:

B

Device temperature alarm:
Sensors

Current output

Display

SIL

Lower range value
Navigation Setup > Lower range value
Expert > Output > Lower range value
Description Use this function to assign a measured value to the current value 4 mA.
Note: The limit value that can be set depends on the sensor type used in the
Sensor type parameter (see page 43) and the measured variable assigned
in the Assign current output (PV) parameter.
User entry Depends on the sensor type and the setting for Assign current output (PV).
Factory setting 0

Upper range value

Navigation Setup > Upper range value
Expert > Output > Upper range value
Description Use this function to assign a measured value to the current value 20 mA.
Note: The limit value that can be set depends on the sensor type used in the
Sensor type parameter (see page 43) and the measured variable assigned
in the Assign current output (PV) parameter.
User entry Depends on the sensor type and the setting for Assign current output (PV).

Factory setting

100
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Advanced Setup Submenu

Corrosion Monitoring

Sensor connection cable corrosion can lead to false measured value readings. Therefore the unit
offers the possibility of recognizing any corrosion before a measured value is affected. Corrosion
monitoring is only possible for RTDs with a 4-wire connection and thermocouples.

Drift/Difference Mode

If two sensors are connected and the measured values differ by a specified value, a status signal is
generated as a diagnostic event. The drift/difference monitoring function can be used to verify the
correctness of the measured values and for mutual monitoring of the connected sensors.

Drift/difference monitoring is enabled with the Drift/difference mode parameter. A distinction is
made between two specific modes. If the In band option is selected (ISV1-SV2I < drift/difference
set point), a status message is issued if the value drops below the set point, or if the value exceeds

the set point if the Out band (drift) option is selected (ISV1-SV2I > drift/difference set point).

1able 11. Procedure for Configuring the Drift/Difference Mode

1. Start
U
2. For drift/difference monitoring, select Out band for drift detection and In band for difference monitoring.

U

3. Set the alarm category for drift/difference to Out of specification (S). Maintenance required (M), or
Failure (F) as required.

U
4. Set the set point for drift/difference monitoring to the desired value.
U
5. End

Figure 18. Drift/difference Mode

L- L-
X t X t
Key:
A Value under range L- Lower (-) set point
B Value over range t time
D Drift X Diagnostics event, status signal is generated

L+ Upper (+) set point

Figure 19 shows how to set the Drift/difference set point.
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Figure 19. Setting Drift/Difference Set Point

%° RTT80V1.01zz/ Dev.Rev 2 # Online parameterization 4 x
Device name: RTTE0 Output current: S 7.90 mA F0 bo O
@;‘} Device tag: WaterTank [4'H S 24,40 =C
) e by Schneider Electric
Status signak ' oK Device temperature: s 26.37 *C
@ O] | Restore & %010 |
|'Menu | variable Sensor offset 1 0.00| =C
I:h—? RTTE0 Sensor offset 2: 0.00| °C
P Access status tooling: —
EH  setup Corrosion detection: Maintenance required (M) |1|
~P Device tag: Drift/difference mode: (0) Out band (drift) |E|
| Unit: o - - —
P Sensor type 1: Drift/difference alarm category: (4) Maintenance required (M) |1|
~P Connection type 1: Drift/difference alarm delay: 5 s
~-PC1 Sensor type 2t
Drift/difference set point: ’ Hl| =

P Connection type 2:

P Assign current output (PV):
P Lower range value:

1 Upper range value:

[EHZ  Advanced setup

| Enter access code:

P Access status tooling:

P Locking status:

P Device temperature alarm:

[FHr  Sensors
=1 Sensor offset 1:

Sensor offset 2:

Corrosion detection:

Drift/difference mode:

Drift/difference alarm cate

Drift/difference alarm dela

Enter access code

Navigation Setup > Advanced setup > Enter access code
Expert > Enter access code

Description Use this function to enable the service parameters via the operating tool. If an
incorrect access code is entered, the user retains his current access
authorization.
NOTE: If a value is entered that is not to equal to the access code, the parameter
is automatically set to 0. The service parameters should only be modified by the
service organization.

User entry 0 to 9999

Factory setting 0
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Access status tooling

Navigation

Setup > Advanced setup > Access status tooling
Expert > Access status tooling

Description

Use this function to show access authorization to the parameters.

Additional information

If additional write protection is active, this restricts the current access
authorization even further. The write protection status can be viewed via the
Locking status parameter.

User entry » Operator
» Service
Factory setting Operator

Locking status

Navigation Setup > Advanced setup > Locking status
Expert > Locking status
Description Use this function to view the device locking status. The DIP switch for hardware

locking is fitted on the display module. When write protection is activated, write
access to the parameters is disabled.

Device temperature alarm

Navigation

Setup > Advanced setup > Device temperature alarm

Description

Use this function to select the category (status signal) as to how the device reacts
when the electronics temperature of the transmitter exceeds or falls below the
limit value < -40°C (-40 °F) or > +85 °C (+185 °F).

Options

» Off
» Out of specification (S)
» Failure (F)

Factory setting

Out of specification (S)

Sensor Submenu

Sensor offset n

NOTE: n = Stands for the number of sensor inputs (1 and 2)

Navigation Setup > Advanced setup > Sensor > Sensor offset n
Expert > Sensor > Sensor n > Sensor offset n

Description Use this function to set the zero point correction (offset) of the sensor measured
value.
The value indicated is added to the measured value.

User entry -10.0 to +10.0

Factory setting 0.0
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Corrosion detection

Navigation

Setup > Advanced setup > Sensor > Corrosion detection
Expert > Sensor > Diagnostics settings > Corrosion detection

Description

Use this function to select the category (status signal) which is displayed when
corrosion is detected in the sensor connection cables.

NOTE: Only possible for RTD sensors with 4-wire connection and thermocouples
(TC).

User entry

» Maintenance required (M)
» Failure (F)

Factory setting

Maintenance required (M)

50

If the sensor selection is 4-wire RTD or thermocouple, the Corrosion detection option is
enabled (see Figure 20). Corrosion detection can be signaled as Maintenance required or

Failure.
Figure 20. Corrosion Detection Option
%% RTT80V1.01.zz / Dev.Rev 2 # Online parameterization 1
Device name: RTTE0 Output current: ﬁa 7.90 mA F b
f;‘j Device tag: WaterTank PV: S 24,383 °C ox O ro
R by Schneider Electric
Status signalk u oK Device temperature: 26.01 =C
@ DB | [Restore Mg+ 0|0
|'Menu | variable Sensor offset 1 0.00| =C
[EH  RTTSO Sensor offset 2: 0.00) °C
1 Access status tooling: -
B Setwp Corrosion detection: ’ Maintenance required (M) e
P Device tag: Drift/difference mode:
e Unit: Failure (F)
--PC1 Sensor type 1t
--P1  Connection type 1:
~-PC1 Sensor type 2t
--P1  Connection type 2:
P Assign current output (PV):
P Lower range value:
P Upper range value:
[EHir  Advanced setup
P Enter access code:
P Access status tooling:
P Locking status:
P Device temperature alarm:
[FHr  Sensors
Sensor offset 1:
Sensor offset 2:
Corrosion detection:
Drift/difference mode:
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Drift/difference mode

Navigation Setup > Advanced setup > Sensor > Drift/difference mode
Expert > Sensor > Diagnostic settings > Drift/difference mode
Description Use this function to choose whether the device reacts to the drift/difference limit

value being exceeded or undershot.

Note: Can only be selected for 2-channel operation.

Additional information

» If the Out band (drift) option is selected, a status signal is displayed if the
absolute value for the differential value exceeds the drift/difference set point

» If the In band option is selected, a status signal is displayed if the absolute
value for the differential value drops below the drift/difference set point.

Options » Off
» Out band (drift)
» In band
Factory setting Off

Drift/difference alarm category

Navigation

Setup > Advanced setup > Sensor > Drift/difference alarm category
Expert > Sensor > Diagnostic settings > Drift/difference alarm category

Prerequisite

The Drift/difference mode parameter must be activated with the Out band (drift)
or In band option.

Description Use this function to select the category (status signal) as to how the device reacts
when a drift/difference is detected between sensor 1 and sensor 2.
User entry » Out of specification (S)

» Maintenance required (M)
» Failure (F)

Factory setting

Maintenance required (M)

Drift/difference alarm delay

Navigation

Setup > Advanced setup > Sensor > Drift/difference alarm delay
Expert > Sensor > Diagnostic settings > Drift/difference alarm delay

Prerequisite

The Drift/difference mode parameter must be activated with the Out band (drift)
or In band option (see page 51).

Description Alarm delay for drift detection monitoring.
Note: Useful for example in the event of different thermal mass ratings for the
sensors in conjunction with a high temperature gradient in the process.
User entry 0to255s

Factory setting

Os

Drift/difference set point

Navigation

Setup > Advanced setup > Sensor > Drift/difference set point
Expert > Sensor > Diagnostic settings > Drift/difference set point

Prerequisite

The Drift/difference mode parameter must be activated with the Out band (drift)
or In band option.

Description Use this function to configure the maximum permissible measure value deviation
between sensor 1 and sensor 2 which results in drift/difference detection.
User entry 0.11t0999.0 K (0.18 to 1798.2 °F

Factory setting

999.0
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Sensor switch set point

Navigation Setup > Advanced setup > Sensor > Sensor switch set point
Expert > Sensor > Diagnostic settings > Sensor switch set point

Description Use this function to set the threshold value for sensor switching (see page 46).

Additional information The threshold value is relevant if the sensor switching function is assigned to a
HART® variable (PV, SV, TV, QV).

User entry Depends on the sensor types selected.

Factory setting 850 °C

Current Output Submenu

Adjustment of the Analog Output (4 to 20 mA Current Trimming)

Current trimming is used to compensate the analog output (D/A conversion). Here, the output
current of the transmitter must be adapted so that it suits the value expected at the higher-order

system.

— NOTE

Current trimming does not affect the digital HART® value. This can cause the

measured value shown on the plug-in display to differ from the value displayed in the
higher-order system.

The digital measured values can be adapted with the sensor trimming

parameter in the menu Expert > Sensor > Sensor trimming.

Table 12. Procedure for Adjusting Analog Output

1. Start
U
2. Install an accurate ammeter (more accurate then the transmitter) in the current loop.
U
3. Switch on current output simulation and set the simulation value to 4 mA.
U
4. Measure the loop current with the ammeter and make a note of the value.
U
5. Set the simulation value to 20 mA.
U
6. Measure the loop current with the ammeter and make a note of the value.
U
7. Enter the current values determined as adjustment values in the Current trimming 4 mA/20 mA
parameters.
U
8. End
Output current
Navigation Setup > Advanced setup > Current output > Output current
Expert > Output > Output current
Description Use this function to view the calculated output current in mA.
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Measuring mode

Navigation Setup > Advanced setup > Current output > Measuring mode
Expert > Output > Measuring mode
Description Enables the inversion of the output signal.

Additional information

» Standard

The output current increases with increasing temperatures
» inverted

The output current decreases with increasing temperatures

Options » Standard
» inverted
Factory setting Standard

Out of range category

Navigation

Setup > Advanced setup > Current output > Out of range category
Expert > Output > Out of range category

Description Use this function to select the category (status signal) as to how the device reacts
when the value is outside the set measuring range.
Options » Out of specification (S)

» Maintenance required (M)
» Failure (F)

Factory setting

Maintenance required (M)

Failure mode

Navigation Setup > Advanced setup > Current output > Failure mode
Expert > Output > Failure mode
Description Use this function to select the signal on alarm level of the current output in the

event of an error.

Additional information

If Max. is selected, the signal on alarm level is specified using the Failure current
parameter.

Options » Min.
» Max.
Factory setting Max.

Failure current

Navigation

Setup > Advanced setup > Current output > Failure current
Expert > Output > Failure current

Prerequisite

The Max. option is enabled in the Failure mode parameter.

Description

Use this function to set the value the current output adopts in an alarm condition.

User entry

21510 23.0 mA

Factory setting

22.5
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Current trimming 4 mA

Navigation Setup > Advanced setup > Current output > Current trimming 4 mA
Expert > Output > Current trimming 4 mA

Description Use this function to set the correction value for the current output at the start of
the measuring range at 4 mA (see page 52).

User entry 3.85t04.15 mA

Factory setting 4 mA

Current trimming 20 mA

Navigation Setup > Advanced setup > Current output > Current trimming 20 mA
Expert > Output > Current trimming 20 mA

Description Use this function to set the correction value for the current output at the end of the
measuring range at 20 mA (see page 52).

User entry 19.850 to 20.15 mA

Factory setting

20.000 mA

Display Submenu

The settings for displaying the measured value on the optional plug-in display are made in the

Display menu.
— NOTE

These settings do not have any effect on the output values of the transmitter. They are
only used to configure how information is shown on the display.

Display interval

Navigation

Setup > Advanced setup > Display > Display interval
Expert > System > Display > Display interval

Description

Use this function to set the length of time the measured values are displayed if the
values alternate on the display. The display only alternates between values if
more than one measured value is defined.
Note:
» The Value 1 display - Value 3 display parameters are used to specify what
measured values are shown on the display (see page 56).
» The display format of the displayed measured values is specified using the
Format display parameter.

User entry

41t020s

Factory setting

4s

Format display

Navigation Setup > Advanced setup > Display > Format display
Expert > System > Display > Format display

Description Use this function to select how the measured value is shown on the local display.
The display format Measured value or Measured value with bar graph can be
configured.

User entry » Value only

» Value + Bargraph
Factory setting Value only

Additional information

See Figure 21 and Figure 22
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Figure 21. Value only

ADD145EL

Figure 22. Value + Bargraph

ADD1G3ET

The optional display contains several pieces of information as illustrated in Figure 23 below:

Figure 23. Display Information

1able 13. Display Information

Display Information
Tag

Communication icon

Engineering unit

Measured value

Channel of measured value (S1, S2, DT, PV, |, %)
Configuration locked

O O | W| N =
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Table 13. Display Information

Display Information

7 Status (fault communication)

» S = Out of specification — Device is operating outside of its technical specifications

» C = Service mode — Device is in service mode (i.e. device in simulation)

» M = Maintenance required — Measurement is valid but a monitored diagnostic
parameter indicates that maintenance is needed

» F = Fault — Measurement is not valid. The F symbol is appended by a diagnostic code
(See “Maintenance” section)

Value 1 display

Navigation

Setup > Advanced setup > Display > Value 1 display
Expert > System > Display > Value 1 display

Description

Use this function to select one of the measured values to be shown on the local
display.

Note: The Format display parameter is used to specify how the measured
values are displayed (see page 54).

Options

» Process value

» Sensor 1

» Sensor 2

» Output current

» Percent of range

» Device temperature

Factory setting

Process value

Decimal places 1

Navigation

Setup > Advanced setup > Display > Decimal places 1
Expert > System > Display > Decimal places 1

Prerequisite

A measured value is specified in the Value 1 display parameter (see page 56).

Description

Use this function to select the number of decimal places displayed for the display
value. This setting does not affect the accuracy of the device for measuring or
calculating the

value.

Note: If Automatic is selected, the maximum possible number of decimal
places is always shown on the display.

Options

» X

» X.X

» X.XX

P X. XXX

> X.XXXX

» Automatic

Factory setting

Automatic

Value 2 display

Navigation Setup > Advanced setup > Display > Value 2 display
Expert > System > Display > Value 2 display
Description Use this function to select one of the measured values to be shown on the local

display.
Note: The Format display parameter is used to specify how the measured
values are displayed.
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Value 2 display

Options » Off

» Process value

» Sensor 1

» Sensor 2

» Output current

» Percent of range

» Device temperature

Factory setting Off

Decimal places 2

Navigation Setup > Advanced setup > Display > Decimal places 2
Expert > System > Display > Decimal places 2
Prerequisite A measured value is specified in the Value 2 display parameter.
Description Use this function to select the number of decimal places displayed for the display

value. This setting does not affect the accuracy of the device for measuring or
calculating the
value.
Note: If Automatic is selected, the maximum possible number of decimal
places is always shown on the display.

Options » X

» X.X

> X.XX

P X.XXX

P X.XXXX

» Automatic

Factory setting Automatic

Value 3 display

Navigation Setup > Advanced setup > Display > Value 3 display
Expert > System > Display > Value 3 display

Description Use this function to select one of the measured values to be shown on the local
display.
Note: The Format display parameter is used to specify how the measured
values are displayed.

Options » Off

» Process value

» Sensor 1

» Sensor 2

» Output current

» Percent of range

» Device temperature

Factory setting Off

Decimal places 3

Navigation Setup > Advanced setup > Display > Decimal places 3
Expert > System > Display > Decimal places 3
Prerequisite A measured value is specified in the Value 3 display parameter.
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Decimal places 3
Description

Use this function to select the number of decimal places displayed for the display
value. This setting does not affect the accuracy of the device for measuring or
calculating the
value.
Note: If Automatic is selected, the maximum possible number of decimal
places is always shown on the display.

Options » X

» X.X

> XXX

> X. XXX

> X.XXXX

» Automatic

Factory setting Automatic

Figure 24 shows how the display can be configured to alternate between up to three selected
parameters at adjustable intervals and decimal point resolution.

Figure 24. Configure Display Settings

%% RTT80V1.01.zz / Dev.Rev 2 # Online parameterization

Device name: RTTB0 Output current: 7.91 mA F b
ti? Device tag: WaterTank PV: 24.44 °C
p ) by Schnelder Electric
Status signak 4 ok Device temperature: 25.84 °C
ignak ‘

@E m E| Restore

M &% 0|0

|'Menu | Variable

Display interval:

EHey  RTTBO

[P Access status tooling:
L  Setup

! Device tag:

PO Enter access code:
P Access status tooling:
~PJ  Locking status:
=] Device temperature alarm:
Hizy  Sensors
~p Sensor offset 1:
P Sensor offset 2:
P Corrosion detection:
- Drift/difference mode:
[+ Currentoutput
My Display
-1 Display interval:
-pJ  Format display:
- Value 1display:
P Decimal places 1:
- Value 2 display:

- Value 3 display:

58

.

Format display:

Value 1 display:

Value only

(v
Process value |z|
v
v

Dedimal places 1: XXX
Unit:
Sensor type 1 Value 2 display: Qutput current
~P1 Connection type 1: Decimal places 2: P xxx ™
o Copecton e TEEE T
P Assign current output (PV): XX
#1 Lower range value:
P Upper range value: 2,20
[EHay  Advanced setup AN
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SIL Submenu: Activation and Deactivation of SIL
Although the RTT80 Functional Safety Manual, MI 020-584, should be referred to for details of

SIL mode operation, some basic operations are described here.

The RTTS80-T is available in two versions, SIL and non-SIL. The SIL version has '-S2' in the
options field of the model code (RTT80-T.....-S2), whereas the non-SIL version does not. As
shown in Figure 1, SIL also appears on the identification label of the SIL version. When
configuring by means of a HART handheld configurator or the HART DTM, the versions can be
distinguished by looking at whether SIL option is checked as Yes or No.
The DTM screenshot in Figure 25 shows navigation to the SIL option through Setup>Advanced
setup>SIL.

Figure 25. RTT80 with SIL Option in Normal Mode
RTT80 V1.01.zz / Dev.Rev 2 # Online parameterization 4 F

&

Device name: RTTE0 Output current: 7.89 mA

Foxboro

by Schneider Electric

%::E Device tag: WaterTank Pv: 24.29

Status signak ‘ ok Device temperature: 26,43 =C

| @& BB | [restre M & 4% 00
|'Menu,|fh'ariable SIL option: ) Yes
[EHEZ  RTTE0

LPC1 Access status tooling:

Operational state: Ea Mormal mode

B  Ssewp

P Device tag:

P Unit:

P Sensor type 1t
-1 Connection type 1:
-F1  Sensor type 2:
-p  Connection type 2:
-PC1 Assign current output (PV):
P11 Lower range value:
-1 Upper range value:
EHr  Advanced setup

Enter access code:

Access status tooling:
Locking status:

Device temperature alarm:
Sensors

Current output

Display

SIL

=
P Operational state:
Activate SIL

4% Restart device

Er-,__[ Administration

|:__'|-,__| Diagnostics

IEI-,__[ Expert

An RTT80 with SIL option can be operated in SIL mode or Normal mode. In Normal mode,
the transmitter is operated and configured just like a non-SIL RT'T80.
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Activation of SIL Mode

In order to activate the SIL mode, the transmitter must undergo the process of Safe
parameterization. This process is initiated by clicking Activate SIL and entering the
access code 7452, as shown in Figure 26, then pressing Enter and clicking Next.

Figure 26. Initiating SIL Activation

|4 RTT80V1.0122 / Dev.Rev 2 # Online parameterization | 4p
Device name: RTT80 Output current: 7.90 mA Fo b 0 ro
25?} Device tag: WaterTank PV: 24,38 °C
Device fure: 27.00 °C by Schneider Electric
Status signal: @ oK evice temperature: .
@ DRG] | restore FEXI
|'Menu | Variable Enter access code: & ) 7452
EH:-’ RTTE0 Please enter SIL access code:
P Access status tooling: After entering the correct access code the device
EHiz  Setup will reset the SIL user parameters to default
--F Device tag: values.
~P1 Unit:
P Sensor type L Serial number: J600770445C
~P Connection type 1. In this step of the wizard the devices serial
P Sensor type 2: number is displayed. Make sure you are working at
PO Conmection 2 the right device.
P Assign current output (PV):
P Lower range value:
I Upper range value:

Advanced setup
Enter access code:
Access status tooling:
Locking status:
Device temperature alarm:
Sensors
Current output
Display
SIL

SIL option:
-F1  Operational state:

ST Activate SIL

|

) Restart device
-|_j Administration
I;}Lj Diagnostics
FCH  Expert
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The user is then prompted through the parameterization process starting with selection of Unit
(Figure 27), and proceeding through all other parameters that can be configured in SIL mode:
Sensor type, Connection type, Mains filter (Figure 29), Upper range value, lower range value, etc.

Figure 27. Online Parameterization

|% RTT80V1.0122/ Dev.Rev 2 # Online parameterization | q
Device name: RTTE0 Output current: 3.58 mA Fo b 0 ro
t;’_-‘} Device tag: WaterTank PY: £ nas = X
R X by Schneider Electric
Status signak @ Failure (F) Device temperature: 6.26 C
[ (] | [Restore & %+ 0@
Unit: (32) =T
Parameter verification: 32FEND

*For more information about the ASCII representation
codes, please refer safety manual.

Confirm: | ™

Yes

Parameters are all set to defaults when parameterization begins. Each time a value is changed, the
pen icon will appear requiring the user to press Enter, and then click Next. Then a

confirmation screen appears (Figure 28) in which the user must select Yes, press Enter, and then
Next.

Figure 28. Confirmation Screen

Jﬁ RTT80 V1.01.zz / Dev.Rev 2 # Online parameterization l q
Device name: RTTE0 Output current: 3.58 mA F0 bo ro
tﬁ- Device tag: WaterTank PV: 2 zas = X
i . by Schneider Electric
Status signal: @ Failure (F) Device temperature: £HA& T
DS | [restore FEXD
Unit: (32)
Parameter werification: 32#END

*For more information about the ASCII representation
codes, please refer safety manual.

Confirm: & ’
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Figure 29. Default Mains Filter is 50 Hz-In this figure it is being changed to 60 Hz

4 RTTB0V1.012z/Dev.Rev 2 # Online parameterization 4

Device name: RTTE0 Output current: Q 3.58 mA F0 b 0 ro
%;ﬁ"' Device tag: WaterTank PV: 23.59 =C X
. ) by Schnelder Electric
Status signak ‘ QK Device temperature: 25.70 =C
|| [Restore FEXII
Assign current output (PV): (D) Sensor 1
Assign SV: (1) Sensor 2
Assign TV: (4) Difference
Assign QV: (2) Device temperature
Please select the mains filter for A/D conversion
Mains filter: & P (eoHz
{0} 50 Hz

SIL mode requires that parameters be defined and verified individually prior to putting the
transmitter into SIL mode. The setting of SIL startup mode is very important (Figure 30).
Not only does this setting determine whether the transmitter will come up in SIL mode after a
power cycle, it determines, as will be seen below, whether the recording of a Checksum value will
be required in order to get back into SIL mode without going through the entire parameterization
again. SIL startup mode should be Enabled if the user wishes to come back into SIL mode
after a power cycle without having to enter a Checksum or re-parameterize.

Figure 30. Setting SIL Startup Mode

4 RTTB0V1.01.2z / Dev.Rev 2 # Online parameterization

Device name: RTTS0 Output current: EQ 3.58 mA
i&tﬁ Device tag: WaterTank PV 23.44 =C
Status signal ‘ oK Device temperature: 25,35 °C
RS | Restore & %+ 00
SIL HART mode: (1) HART enabled in 5IL mode
SIL startup mode: ’ (0} Disabled
(0) Disabled
(1) Enabled |
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After all parameter selections have been made, a Parameterization Summary screen will appear
and prompt the user for a final confirmation of the configuration (Figure 31).

Figure 31. Parameterization Summary

|4 RTTBO0V1.01.2z/ Dev.Rev 2 # Online | ization | q
Device name: RTTB0 Output current: c; 3.58 mA b
_ - Foxboro
@ Device tag: WaterTank PV: Re 2349 °C
- by Schneider Eiectri
— - Device temperature: {) 2527 °C S
ignal:
G| oo & ® 00
Sensor 1 General device settings
Sensor 1: (12) Pt100 IECE0751, a=0.00385 (1) Unit: (32) C
Sensor offset 1: 0.00 Mains filter: (1) 60 Hz
Connection 1: (3) 3- wire Drift/difference mode: (0) Out band (drift)
Call. fv. Dusen coeff. A: 0.0039083 Drift/difference alarm category: (4) Maintenance required (M)
Call. fv. Dusen coeff. B: -5.775E-07 Drift/difference alarm delay: 5 5
Call. fv. Dusen coeff. C: -4.183E-12 Drift/difference set point: 2,00 *C
Call. fv. Dusen coeff. RO: 100.000 SIL startup mode: (1) Enabled
Polynomial coeff. A: 0.0054963 Current output
Polynomial coeff. B: 6.7556E-06 Lower range value: 0.00] °C
Polynomial coeff. RO: 100,000 rrange val 100.00 °C
Sensor 1 lower limit: -200.00 Qut of range category: (4) Maintenance required (M)
= Not used parameters
nsor r limit: 850,00 =C
Failure current: 22,50 mA
j : 1) Internal t
rence junction (1) 1In measuremen HART output
Rl preset value 1: 0.00 Assign curren: ) (0) Sensor 1
SSe2 Assign SV (1) Sensor 2
Sensor tvpe 2: (12) Pt100 IEC60751, 2=0.00385 (1) :
Assign TV: (4) Difference
Sensor offset 2: 0.00
. Assign QV: (2) Device temperature
nnecti (3) 3- wire
SIL HART mode: (1) HART enabled in SIL mode
Call. /v. Dusen coeff, A: 0.0039083
Confirm: Mo
Golox. Mt e = SEY Vo |
Call. fv. Dusen coeff, C: -4,1836-12 Yes
Call. fv, Dusen coeff, RO: 100.000
Polynomial coeff, A: 0.0054963
Polynomial coeff, B: 6.7556E-06
Polynomial coeff. RO: 100.000
Sensor 2 lower limit: ~200.00
Sensor 2 upper limit: 850.00  =C
Reference junction 2: (1) Internal measurement
RJ preset value 2: 0.00
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Next a SIL checksum screen will appear (Figure 32). Again, if SIL startup mode is not
Enabled, this checksum will need to be entered after a power cycle in order to avoid
re-parameterization.

Figure 32. SIL Checksum

J#" RTT80 V1.01.zz / Dev.Rev 2 # Online parameterization ]

Device name: RTTE0 Output current: EQ 3.58 mA F b
2;‘? Device tag: WaterTank PV: 23.60 °C M
= R by Schneider Electric
Status signak @ ok Device temperature: {3 2525 °C
]| resore EEXID

The CRC check value calculated with the selected Safe
Parameters configuration is displayed below

SIL checksum: 47425

Please write down the CRC chedk value. You will need it to
restart the device in SIL mode.

Enter SIL Checksum: a2 47424

Timestamp SIL configuration: 27-05-2015 13:31

Once the SIL checksum has been confirmed, instructions to click Next in order to reboot into
SIL mode will appear (Figure 33).

Figure 33. Restart in SIL Mode

J#" RTT80 V1.01.zz / Dev.Rev 2 # Online parameterization ]

Device name: RTTE0 Output current: EQ 3.58 mA

2;.5‘ Device tag: WaterTank PV: 2371 °C Fox b 0 rO

- . by Schneider Electric
Status signak: @ oK Device temperature: s 25.22 =C

B |[Restore FEEXI)

By dick on Text” button, the safe
parameterization will be finished and the
device will be restarted. After restart the
device will be ready to start in SIL mode.
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A disconnect message will appear as the transmitter reboots (Figure 34). Be aware that during the
transmitter reboot, it may appear as if nothing is happening. Be assured that the transmitter is
actively in the process of reboot. Patience is advised.

Figure 34. Reboot

|4 RTTBOV1.0122/Dev.Rev 2 Online |

Device name:

ti‘} Device tag:

Output current: H

PV:

Foxboro

by Schnelder Electric

P Enter access code:
P Access status tooling:
P Locking status:

Sensors
Current output
Display

SIL

Operational state:
SIL startup mode:

SIL HART mode:
Restart device

Administration

Device temperature alarm:

SIL oplion:

Timestamp SIL configurati

Status signal: u Device temperature: { )

@ i [ & | Restore V& %00

[Menu / variable SIL option: P ves

E}@:r RTTS0 £ [Reboot pendi

é---#CI Access status tooling:
91{.7 Setup 27-05-2015 13:31
P Device tag: (1) Enabled
= Unit:
.p0 Sensor type 1: (1) HART enabled in SIL mode
P Connection type 1:
pJ  Reference junction 1:
P R preset value 1:
P Sensor type 2:
P Connection type 2:
P Reference junction 2:
= RJ preset value 2:
-3 Assign current output (PV):
P Lower range value:
P Upper range value:
By  Advanced setup

Connection to device not established...
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After reboot, the system will come up in the Waiting for checksum state (Figure 35). If STL
startup mode is Enabled, this state will time out after a minute or so and go to SIL mode
active state (Figure 36). If SIL startup mode is Disabled, the SIL checksum has to be
entered in order for startup to continue into SIL mode without re-parameterization.

Again, if you have selected SIL startup mode to be enabled, you only need to wait for the
checksum field to time out. No further action is required to go into SIL mode after startup.

Device name: 7

ti? Device tag:

Figure 35. Waiting for SIL Checksum

%% RTT80 V1.01.zz / Dev.Rev 2 # Online parameterization

RTTB0

WaterTank

Output current:

PV:

(W) 3.58 mA

§999.99 °C

Foxboro

by Schnelder Electric

Status signal: S?/ Function check (C) Device temperature: ? 25,25 °C
@ 0| [E) | |Restore Mg 0|0
|'Menu | Variable SIL option: P Yes
Eh‘? ? RTTS0 Operational state: Wait for Checksum
1 Actual diagnostics:
Enter SIL Checksum: 0

{
B&=?
| =
=)

= ? Access status tooling:

iy P Setup
} Device tag:
Uniit:

P Sensor type 1t

-#1 Connection type 1:
P Reference junction 1:
P RJpreset value 1:
P Sensor type 2:

P Connection type 2:
P Reference junction 2:

RJ preset value 2:
Assign current output (PV):
Lower range value:
Upper range value:
Advanced setup

Enter access code:
? Access status tooling:
Locking status:
Device temperature alarm:
Sensors
Current output
Display

SIL
Operational state:
Enter SIL Checksum:
Timestamp SIL configurati
SIL startup mode:
SIL HART mode:
Deactivate SIL
Restart device

Timestamp SIL configuration:
SIL startup mode:
SIL HART mode:

27-05-2015 13:31
(1) Enabled
(1) HART enabled in SIL mode
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|4 RTTBOV1.01.22/Dev.Rev 2 # Online p

l

Figure 36. SIL Mode Active

Device name: RTTB0

& Device tag: WaterTank

4 o

Status signal:

Output current:

[4'H

Device temperature: c)

7.80 mA

23.76 =C

25.20 =C

Foxboro

by Schnelder Electric

® IE"Q"EI | |Restore

V& %00

SIL option:

RTT80
Access status tooling:
EH  setwp
P Device tag:
=P Unit:
P Sensor type 1:
P Connection type 1:
P Reference junction 1:
P RJpreset value 1:
P Sensor type 2:
~PJ  Connection type 2:
P Reference junction 2:
P RJpreset value 2:
P Assign current output (PV):
P Lower range value:
P Upper range value:
[EHay  Advanced setup
P Enter access code:
P Access status tooling:
~PJ  Locking status:
-~ Device temperature alarm:
[ Sensors
[  Current output
++[1  Display
HZ  SIL

e

-7

'

Operational state:

SIL startup mode:
SIL HART mode:
Force safe state:
Restart device

SIL option:

Timestamp SIL configuratio

Operational state:
Timestamp SIL configuration:
SIL startup mode:

SIL HART mode:

Force safe state:

P ves
SIL mode active
27-05-2015 13:31
(1) Enabled
(1) HART enabled in SIL mode
Off
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Deactivating SIL Mode

Note that in Figure 35, after reboot while the system is waiting for the SIL checksum, there is a
Deactivate SIL option in the SIL submenu, but that this option was no longer present when
the SIL mode active state was attained (Figure 36).

In order to put the transmitter in Normal mode operational state, the Deactivate SIL menu
option must be present. This can be achieved by clicking Restart device as shown in
Figure 37. This sets up the reboot sequence which returns the system in a minute or so to the
Waiting for checksum state where the Deactivate SIL menu option is available for a
minute or so. Clicking Deactivate SIL returns the device to the Normal mode after a short

wait.
Figure 37. Restart Device to Enable Deactivate SIL Option

%% RTT80V1.01.zz / Dev.Rev 2 # Online parameterization 1 bk X

Device name: RTTB0 Output current: s 7.89 mA
:i? Device tag: WaterTank PV: s 24,32 =C Fox b 0 ro

. _ by Schneider Eiectric

Status signak u ok Device temperature: 26.10 =C
@ |0 B[] | Restore & %010 |
|'Menu [ Variable Use button "Restart device” to restart

the device.

[EHgr RTTBO
é---PJ Access status tooling:
Setup
Device tag:
Unit:
Sensor type 1:
~P  Connection type 1:
P Reference junction 1:
P RJpreset value 1:
P Sensor type 2:
P Connection type 2:
P Reference junction 2:
P R preset value 2:
P Assign current output (PV):
P Lower range value:
P Upper range value:
[EHay  Advanced setup
P Enter access code:
P Access status tooling:
P Locking status:
P Device temperature alarm:
3  Sensors
[#+d  Current output
[+  Display
B sn

SIL option:
Operational state:

SIL startup mode:
SIL HART mode:
Force safe state:

=
=
O Timestamp SIL configuratio
=
=
=

A
Eh_l Administration

[+  Diagnostics

[#+3  Expert

El#l |o Restart device | a

| & Online | L

=
-
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SIL option
Navigation Setup > Advanced setup > SIL option
Description Indicates whether the device has been ordered with SIL certification. SIL
certificate of the device.
Note: The SIL option is required to operate the device in the SIL mode.
Options » No
» Yes
Factory setting No

Operational state

Navigation Setup > Advanced setup > SIL > Operational state
Description Displays the device operational state in the SIL mode.
Options » Checking SIL option

» Startup normal mode
» Wait for checksum

» Self diagnostic

» Normal mode

» Download active

» SIL mode active

» Safe para start

» Safe param running

» Save parameter values
» Parameter check

» Reboot pending

» Reset checksum

» Safe state - Active

» Download verification
» Upload active

» Safe state - Passive

» Safe state - Panic

NOTE: If the device is restarted with the setting SIL startup mode > Not active,
Wait for checksum appears in this parameter. The SIL checksum must be
entered manually here.

Factory setting

Checking SIL option

Enter SIL checksum

Navigation Setup > Advanced setup > SIL > Enter SIL checksum

Description Use this function to enter the SIL checksum during safe parameterization and
startup in conjunction with the parameter setting SIL startup mode > Not active.
NOTE: If the parameter setting is SIL startup mode > Not active and the value
'0' is entered, automatic startup is aborted and the SIL settings are discarded.

User entry 0 to 65535

Factory setting

0
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Timestamp SIL configuration

Navigation Setup > Advanced setup > SIL > Timestamp SIL configuration

Description Use this function to enter the date and time when safe parameterization has been
completed and the SIL checksum has been calculated.
NOTE: The date and time must be entered manually. This information is not
generated automatically by the device.

User entry DD.MM.YYYY hh:mm

Factory setting

0

SIL startup mode

Navigation Setup > Advanced setup > SIL > SIL startup mode

Description Setting for repeated automatic device startup in the SIL mode, e.g. after a power-
cycle.
NOTE: The Not active setting requires the user to enter the SIL checksum
manually in order to be able to start the device again in SIL mode.

Options » Not active

» Active
Factory setting Not active

SIL HART mode

Navigation Setup > Advanced setup > SIL > SIL HART mode

Description Setting for HART® communication in the SIL mode. The HART not active setting
disables HART® communication in the SIL mode (only 4 to 20 mA
communication is active).

Options » HART not active

» HART active

Factory setting

HART active

Force safe state

Navigation Setup > Advanced setup > SIL > Force safe state

Prerequisite The Operational state parameter displays SIL mode active.

Description During SIL proof testing this parameter is used to test error detection and the safe
state of the device.
NOTE: A detailed description of SIL proof testing is provided in the Functional
Safety Manual MI 020-584.

Options »On

» Off

Factory setting

Off
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Administration Submenu

Device reset

Navigation Setup > Advanced setup > Administration > Device reset
Expert > System > Device reset

Description Use this function to reset the device configuration - either entirely or in part - to a
defined state.

Options » Not active

No action is executed and the user exits the parameter.

» To factory defaults
All the parameters are reset to the factory setting.

» To delivery settings
All the parameters are reset to the order configuration. The order
configuration can differ from the factory setting if customer-specific parameter
values were defined when the device was ordered.

» Restart device
The device is restarted but the device configuration remains unchanged.

Factory setting

Not active

Define device write protection code

Navigation Setup > Advanced setup > Administration > Device device write protection code
Expert > System > Device device write protection code

Description Sets a write protection code for the device.
Note: If the code is programmed into the device firmware it is saved in the
device and the operating tool displays the value 0 so that the defined write
protection code is not openly displayed for viewing.

User entry 0 to 9999

Factory setting 0

Note: If the device is delivered with this factory setting the device write
protection is not active.

Additional information

» Activating device write protection: device write protection is activated via the
software by entering a 4-digit code in the Enter access code parameter.
This code and the defined write protection code may not be the same!

» Deactivating device write protection: if device write protection is activated,
enter the defined write protection code in the Enter access code parameter.

» Once the device has been reset to the factory setting or the order
configuration, the defined write protection code is no longer valid. The code
adopts the factory setting (= 0).

» Hardware write protection (DIP switches) is active:

» Hardware write protection has priority over the software write protection
described here.

» No value can be entered in the Enter access code parameter. The
parameter is a read only parameter.

» Device write protection via software can only be defined and activated if
hardware write protection via the DIP switches is disabled.
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Diagnostics Menu

All the information that describes the device, the device status and the process conditions can be
found in this group.

Actual diagnostics 1

Navigation Diagnostics > Actual diagnostics
Expert > Diagnostics > Actual diagnostics 1

Description Use this function to display the current diagnostics message. If two or more
messages occur simultaneously, the message with the highest priority is shown
on the display.

Display Symbol for event behavior and diagnostic event.

Additional information Example for display format:
F261-Electronics modules

In Figure 38, the Actual diagnostics indicates Sensor drift, meaning the difference in
readings between two sensors is outside the band set in Drift/difference mode. If the L1
display is in use, the M044 code will be displayed.

Figure 38. Actual Diagnostics

%° RTT80V1.01zz/ Dev.Rev 2 # Online parameterization <
Device name: RTTE0 Output current: 8.97 mA F b
f;‘} Device tag: WaterTank PV: 3126 °C
) by Schneider Electric
- ] ) ) p - L
Status signak: @ Maintenance required (M) Device temperature: 2458 °C
@ 0| &= | [Restore Mg+ 0|0
[Menuf\u‘ariable Actual diagnostics: ’ M044 Sensor drift
EhZr  RTTEO Previous diagnostics 1: M044 Sensor drift
P Actual diagnostics: .
P Access status tooling: Operating time: ¥ 362 h
3  Setup

[EH&F  Diagnostics
é---PJ Previous diagnostics 1:
é---PJ Operating time:
E}-,__[ Diagnostic list
E}-,__[ Event logbook
E}-,__[ Device information
E}-,__[ Measured values
E}-,__[ Simulation
[+  Expert

Remedy information

Navigation Diagnostics > Remedy information
Expert > Diagnostics > Remedy information

Description Use this function to display the remedial action to be taken for the current
diagnostics message.

72



4. Operating Menu and Parameter Description

M1 020-585 — November 2022

Previous diagnostics 1

Navigation

Diagnostics > Previous diagnostics 1
Expert > Diagnostics > Previous diagnostics 1

Description

Use this function to display the last diagnostics message with the highest priority.

Display

Symbol for event behavior and diagnostic event.

Additional information

Example for display format:
F261-Electronics modules

Operating time

Navigation Diagnostics > Operating time

Expert > Diagnostics > Operating time
Description Use this function to display the length of time the device has been in operation.
Display Hours (h)

Diagnostic List Submenu

Up to 3 diagnostic messages currently pending are displayed in this submenu. If more than 3
messages are pending, the messages with the highest priority are shown on the display.

Actual diagnostics count

Navigation Diagnostics > Diagnostics list > Actual diagnostics count
Expert > Diagnostics > Diagnostics list > Actual diagnostics count
Description Use this function to display the number of diagnosis messages currently pending

in the device.

Actual diagnostics

Navigation Diagnostics > Diagnostics list > Actual diagnostics
Expert > Diagnostics > Diagnostics list > Actual diagnostics

Description Use this function to display the current diagnostics messages with the highest
priority to the third-highest priority.

Display Symbol for event behavior and diagnostic event.

Additional information

Example for display format:
F261-Electronics modules

Actual diag channel

Navigation Diagnostics > Diagnostics list > Actual diag channel
Expert > Diagnostics > Diagnostics list > Actual diag channel
Description Use this function to display the sensor input to which the diagnostics message
refers.
Display » Sensor 1
» Sensor 2

73



MI 020-585 — November 2022

4. Operating Menu and Parameter Description

Event Logbook Submenu

Previous diagnostics n

NOTE: n = Number of diagnostic messages (n = 1 to 5)

Navigation Diagnostics > Events Logbook> Previous diagnostics n
Expert > Diagnostics > Diagnostics list > Previous diagnostics n

Description Use this function to display the diagnostics messages that occurred in the past.
The last 5 messages are listed in chronological order.

Display Symbol for event behavior and diagnostic event.

Additional information

Example for display format:
F261-Electronics modules

Previous diag channel

Navigation Diagnostics > Events Logbook > Previous diag channel
Expert > Diagnostics > Diagnostics list > Previous diag channel
Description Use this function to display the possible sensor input to which the diagnostics
message refers.
Display » Sensor 1
» Sensor 2
|
Device Information Submenu

Device tag

Navigation

Setup > Device tag
Diagnostics > Device information > Device tag
Expert > Diagnostics > Device information > Device tag

For details, see “Device tag” on page 43.

Serial number

Navigation

Diagnostics > Device information > Serial number
Expert > Diagnostics > Device information > Serial number

Description

Use this function to display the serial number of the device. It can also be found
on the nameplate.

NOTE: Uses of the serial number
» To identify the measuring device quickly

Display

Max. 11-digit character string comprising letters and numbers

Firmware version

Navigation Diagnostics > Device information > Firmware version

Expert > Diagnostics > Device information > Firmware version
Description Use this function to view the device firmware version installed.
Display Max. 6-digit character string in the format xx.yy.zz
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Device name

Navigation Diagnostics > Device information > Device name
Expert > Diagnostics > Device information > Device name
Description Displays the device name. It can also be found on the nameplate.
Order code
Navigation Diagnostics > Device information > Order code
Expert > Diagnostics > Device information > Order code
Description Use this function to display the order code of the device. It can also be found on

the nameplate. The order code is generated from the extended order code, which
defines all the device features of the product structure. In contrast, the device
features cannot be read directly from the order code.

Note: Uses of the order code:

» To order an identical spare device.

» To identify the device quickly and easily, e.g. when contacting the
manufacturer.

Configuration counter

Navigation

Diagnostics > Device information > Configuration counter
Expert > Diagnostics > Device information > Configuration counter

Description

Use this function to display the counter reading for changes to device parameters.
Note: Static parameters, whose values change during optimization or
configuration, cause this parameter to increment by 1. This support parameter
version management. If several parameters change, e. g. due to loading of
parameters from FieldCare, etc. in the device, the counter can show a higher
value. The counter cannot be reset and is also not reset to the default value
when the device is reset. If the counter overflows, (16 bit), it starts again at 1.

Measured Values Submenu

Sensor n value (a)
Navigation Diagnostics > Measured values > Sensor n value
Expert > Diagnostics > Measured values > Sensor n value
Description Use this function to display the current measured value at the sensor input.

a. n = Stands for the number of sensor inputs (1 and 2)

Device temperature
Navigation Diagnostics > Measured values > Device temperature

Expert > Diagnostics > Measured values > Device temperature
Description Use this function to display the current electronics temperature.
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Min/Max values Submenu

Sensor nh min value (a)

Navigation Diagnostics > Measured values > Min/max values > Sensor n min value
Expert > Diagnostics > Measured values > Min/max values > Sensor n min value
Description Use this function to display the minimum temperature measured in the past at

sensor input 1 or 2 (peakhold indicator).

a. n = Stands for the number of sensor inputs (1 and 2)

Sensor n max value (a)

Navigation

Diagnostics > Measured values > Min/max values > Sensor n max value
Expert > Diagnostics > Measured values > Min/max values > Sensor n max value

Description

Use this function to display the maximum temperature measured in the past at
sensor input 1 or 2 (peakhold indicator).

a. n = Number of sensor inputs (1 and 2).

Reset sensor min/max values

Navigation

Diagnostics > Measured values > Min/max values > Reset sensor min/max
values

Expert > Diagnostics > Measured values > Min/max values > Reset sensor
min/max values

Description Reset the peakhold indicators for the minimum and maximum temperatures
measured at the sensor inputs.
Options » No
» Yes
Factory setting No

Device temperature min.

Navigation

Diagnostics > Measured values > Min/max values > Device temperature min.
Expert > Diagnostics > Measured values > Min/max values > Device temperature
min.

Description

Use this function to display the minimum electronics temperature measured in the
past (peakhold indicator).

Device temperature max.

Navigation Diagnostics > Measured values > Min/max values > Device temperature max.
Expert > Diagnostics > Measured values > Min/max values > Device temperature
max.

Description Use this function to display the maximum electronics temperature measured in

the past (peakhold indicator).
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Reset device temp. min/max values

Navigation Diagnostics > Measured values > Min/max values > Reset device temp. min/max
values
Expert > Diagnostics > Measured values > Min/max values > Reset device temp.
min/max values

Description Reset the peakhold indicators for the minimum and maximum electronic
temperatures measured.

Options » No

» Yes
Factory setting No

Simulation Submenu

Simulation current output

Navigation Diagnostics > Simulation > Simulation current output
Expert > Diagnostics > Simulation > Simulation current output

Description Use this function to switch simulation of the current output on and off. The display
alternates between the measured value and a diagnostics message of the
function check category (C) while simulation is in progress.

Display Measured value display < C491 (simulation current output)

Options » Off

» On
Factory setting Off

Additional information

The simulation value is defined in the Value current output parameter.

Value current output

Navigation

Diagnostics > Simulation > Value current output
Expert > Diagnostics > Simulation > Value current output

Additional information

The Simulation current output parameter must be set to On.

Description Use this function to set a current value for the simulation. In this way, users can
verify the correct adjustment of the current output and the correct function of
downstream switching units.

User entry 3.59 t0 23.0 mA

3.59 mA
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Expert Menu

— NOTE
The parameter groups for the Expert setup contain all the parameters of the Setup
and Diagnostics operating menus, as well as other parameters that are solely
reserved for experts. Descriptions of the additional parameters can be found in this
section. All the fundamental parameter settings for transmitter commissioning and
diagnostic evaluation are described in the “Setup Menu” on page 42 and “Diagnostics

Menu” on page 72.

System Submenu

Damping

Navigation Expert > System > Damping

Description Use this function to set the time constant for current output damping.
User entry 0to120s

Factory setting 0.00s

Additional information The current output reacts with an exponential delay to fluctuations in the
measured value. The time constant of this delay is specified by this parameter. If
a low time constant is entered, the current output follows the measured value
quickly. On the other hand, if a high time constant is entered, the current output

reaction is delayed.

Alarm delay

Navigation Expert > System > Alarm delay

Description Use this function to set the delay time during which a diagnostics signal is
suppressed before it is output.

User entry Oto5s

Factory setting 2s

Mains filter
Navigation Expert > System > Mains filter
Description Use this function to select the mains filter for A/D conversion.
User entry » 50 Hz
» 60 Hz
Factory setting 50 Hz

Device temperature alarm

Navigation

Expert > System > Device temperature alarm
For details, see “Device temperature alarm” on page 49.

Display Submenu

For details, see “Display Submenu” on page 54.
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Administration Submenu

For details, see “Administration Submenu” on page 71.

Sensor Submenu

Sensor 1/2 Submenu

— NOTE
n = the number of sensor inputs (land 2)

Sensor n lower limit
Navigation Expert > Sensor > Sensor n > Sensor n lower limit
Description Displays the minimum physical full scale value.

Sensor n upper limit
Navigation Expert > Sensor > Sensor n > Sensor n upper limit
Description Displays the maximum physical full scale value.

Sensor serial number

Navigation Expert > Sensor > Sensor n > Sensor serial number

Description Use this function to enter the serial number of the connected sensor.
User entry String with up to 12 characters consisting of numbers and/or text.
Factory setting " " (no text)

Sensor Trimming Submenu
Sensor Error Adjustment (Sensor Trimming)

Sensor trimming is used to adapt the actual sensor signal to the linearization of the selected sensor
type stored in the transmitter. Compared to sensor transmitter matching, sensor trimming only
takes place at the start and end value and does not achieve the same level of accuracy.

— NOTE

Sensor trimming does not adapt the measuring range. It is used to adapt the sensor

signal to the linearization stored in the transmitter.
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1able 14. Procedure for Sensor Trimming

1. Start

U

2. Set the Sensor trimming parameter to the Customer-specific setting.

U

3. Using a water/oil bath, bring the sensor connected to the transmitter to a known and stable temperature. A
temperature which is close to the set start of the measuring range is recommended.

U

4. Enter the reference temperature for the value at the start of the measuring range for the Sensor trimming
lower value parameter. Based on the difference between the specified reference temperature and the
temperature actually measured at the input, the transmitter internally calculates a correction factor which is

now used to linearize the input signal.

U

5. Using a water/oil bath, bring the sensor connected to the transmitter to a known and stable temperature

close to the set end of the measuring range.

U

6. Enter the reference temperature for the value at the end of the measuring range for the Sensor trimming

upper value parameter.

U

7.End

Sensor trimming

Navigation Expert > Sensor > Sensor n > Sensor trimming > Sensor trimming
Description Use this function to select the linearization method to be used for the connected
sensor.
Note: The original linearization can be restored by resetting this parameter to
the Factory setting option.
Options » Factory setting

» Customer-specific

Factory setting

Factory setting

Sensor trimming lower value

Navigation

Expert > Sensor > Sensor n > Sensor trimming > Sensor trimming lower value

Prerequisite

The Customer-specific option is enabled in the Sensor trimming parameter
(see “Sensor trimming” on page 80).

Description

Lower point for linear characteristic calibration (this affects offset and slope).

User entry

Depends on the selected sensor type and the assignment of the current output
(PV).

Factory setting

-200 °C
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Sensor trimming upper value

Navigation Expert > Sensor > Sensor n > Sensor trimming > Sensor trimming upper value

Prerequisite The Customer-specific option is enabled in the Sensor trimming parameter
(see “Sensor trimming” on page 80).

Description Upper point for linear characteristic calibration (this affects offset and slope).

User entry I(Dpe\?)ends on the selected sensor type and the assignment of the current output

Factory setting 850 °C

Sensor trimming min span

Navigation Expert > Sensor > Sensor n > Sensor trimming > Sensor trimming min span

Prerequisite The Customer-specific option is enabled in the Sensor trimming parameter
(see “Sensor trimming” on page 80).

Description Use this function to view the minimum possible span between the sensor
trimming upper and lower value.

Linearization Submenu

Table 15. Procedure for Configuring a Linearization using Callendar/Van Dusen Coefficients from a
Calibration Certificate

1. Start

U
2. Assign current output (PV) = set sensor 1 (measured value).
U
3. Select unit (°C).
U
4. Select the sensor type (linearization type) RTD platinum (Callendar/Van Dusen).
U
5. Select connection mode e.g. 3-wire.
U
6. Set the lower and upper sensor limits.
U
7. Enter the four coefficients A, B, C and RO.
U
8. If special linearization is also used for a second sensor, repeat steps 2 to 6.

U

9.End
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Sensor n lower limit

Navigation

Expert > Sensor > Sensor n > Linearization > Sensor n lower value

Prerequisite

The RTD platinum, RTD poly nickel or RTD copper polynomial option is enabled
in the Sensor type parameter.

Description

Use this function to set the lower calculation limit for special sensor linearization.

User entry

Depends on the sensor type selected.

Factory setting

-200 °C

Sensor n upper limit

Navigation

Expert > Sensor > Sensor n > Linearization > Sensor n upper value

Prerequisite

The RTD platinum, RTD poly nickel or RTD copper polynomial option is enabled
in the Sensor type parameter.

Description

Use this function to set the upper calculation limit for special sensor linearization.

User entry

Depends on the sensor type selected.

Factory setting

850 °C

Call./v. Dusen coeff. RO

Navigation

Expert > Sensor > Sensor n > Linearization > Call./v. Dusen coeff. RO

Prerequisite

The RTD platinum (Callendar/Van Dusen) option is enabled in the Sensor type
parameter.

Description Use this function to set the RO Value only for linearization with the Callendar/Van
Dusen polynomial.
User entry 40.000 to 1 050.000

Factory setting

100.000 Ohm

Call./v. Dusen coeff.A,B, C

Navigation

Expert > Sensor > Sensor n > Linearization > Call./v. Dusen coeff. A, B, C

Prerequisite

The RTD platinum (Callendar/Van Dusen) option is enabled in the Sensor type
parameter.

Description

Use this function to set the coefficients for sensor linearization based on the
Callendar/Van Dusen method.

Factory setting

» A: 3.910000e-003
» B: -5.780000e-007
» C: -4.180000e-012

Polynomial coeff. RO

Navigation

Expert > Sensor > Sensor n > Linearization > Polynomial coeff. RO

Prerequisite

The RTD poly nickel or RTD copper polynomial option is enabled in the Sensor
type parameter.

Description Use this function to set the RO Value only for linearization of nickel/copper
sensors.
User entry 40.000 to 1 050.000 Ohm

Factory setting

100.00 Ohm
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Polynomial coeff. A, B

Navigation

Expert > Sensor > Sensor n > Linearization > Polynomial coeff. A. B

Prerequisite

The RTD poly nickel or RTD copper polynomial option is enabled in the Sensor
type parameter.

Description

Use this function to set the coefficients for sensor linearization of copper/nickel
resistance
thermometers.

Factory setting

Polynomial coeff. A = 5.49630e-003
Polynomial coeff. B = 6.75560e-006

Diagnostic Settings Submenu

Calibration counter start

Navigation

Expert > Sensor > Diagnostic settings > Calibration counter start

Description

Option to control the calibration counter.

NOTE:
» The countdown duration (in days) is specified with the Calibration counter
start value parameter.
» The status signal issued when the limit value is reached is defined with the
Calibration alarm category parameter.

Options

» Off: Stops the calibration counter
» On: Starts the calibration counter
» Reset + run: Resets to the set start value and starts the calibration counter

Factory setting

Off

Calibration alarm category

Navigation Expert > Sensor > Diagnostic settings > Calibration alarm category

Description Use this function to select the category (status signal) as to how the device reacts
when the set calibration countdown expires.

Options » Maintenance required (M)

» Failure (F)

Factory setting

Maintenance required (M)

Calibration counter start value

Navigation Expert > Sensor > Diagnostic settings > Calibration counter start value
Description Use this function to set the start value for the calibration counter.
User entry 0 to 365 d (days)

Factory setting

365

Calibration countdown

Navigation

Expert > Sensor > Diagnostic settings > Calibration countdown

Description

Use this function to view the time remaining until the next calibration.

Calibration countdown only runs when the device is active. Example: If the
calibration counter is set to 365 days on January 1, 2011 and no electricity is
supplied to the device for 100 days, the alarm for the calibration appears on April
10, 2012.
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Measuring mode

Navigation

Expert > Output > Measuring mode

Description

Enables the inversion of the output signal.

Additional information

» Standard

The output current increases with increasing temperatures
» inverted

The output current decreases with increasing temperatures

Options » Standard
» inverted
Factory setting Standard

Communication Submenu

HART Configuration Submenu

Device tag

Navigation

Diagnostics > Device information > Device tag
Expert > Communication > HART configuration > Device tag

For details, see “Device tag” on page 43.

HART short tag

Navigation Expert > Communication > HART configuration > HART short tag
Description Use this function to define a short tag for the measuring point.

User entry Up to 8 alphanumeric characters (letters, numbers and special characters)

Factory setting

SHORTTAG

HART address

Navigation Expert > Communication > HART configuration > HART address
Description Use this function to define the HART address of the device.
User entry 0..63

Factory setting 0

Additional information

The measured value can only be transmitted via the current value is the address
is set to 0. The current is fixed at 4.0 mA for all other addresses (Multidrop mode).

No. of preambles

Navigation Expert > Communication > HART configuration > No. of preambles
Description Use this function to define the number of preambles in the HART telegram.
User entry 2..20

Factory setting

5

Configuration changed

Navigation

Expert > Communication > HART configuration > Configuration changed

Description

Indicates whether the configuration of the device has been changed by a master
(primary or secondary).
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Reset configuration changed flag

Navigation Expert > Communication > HART configuration > Reset configuration changed
flag
Description The Configuration changed information is reset by a master (primary or

secondary).

HART Info Submenu

Device type

Navigation Expert > Communication > HART info > Device type

Description Use this function to view the device type with which the device is registered with
the HART Communication Foundation. The device type is specified by the
manufacturer. It is needed to assign the appropriate device description file (DD) to
the device.

Display 2-digit hexadecimal number

Factory setting

Oxcc

Device revision

Navigation

Expert > Communication > HART info > Device revision

Description

Use this function to view the device revision with which the device is registered
with the HART® Communication Foundation. It is needed to assign the
appropriate device description file (DD) to the device.

Factory setting

2

HART revision

Navigation Expert > Communication > HART info > HART revision

Description Use this function to display the HART revision of the device.

HART descriptor

Navigation Expert > Communication > HART info > HART descriptor

Description Use this function to define a description for the measuring point.

User entry Up to 32 alphanumeric characters (letters, numbers and special characters).

Factory setting

The device name

HART message

Navigation Expert > Communication > HART info > HART message

Description Use this function to define a HART message which is sent via the HART protocol
when requested by the master.

User entry Up to 32 alphanumeric characters (letters, numbers and special characters).

Factory setting

The device name
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Hardware revision

Navigation Expert > Communication > HART info > Hardware revision
Description Use this function to display the hardware revision of the device.
SWRev

Navigation Expert > Communication > HART info > SWRev

Description Use this function to display the software revision of the device.
HART date code

Navigation Expert > Communication > HART info > HART data code
Description Use this function to define date information for individual use.
User entry Date in the format year-month-day (YYYY-MM-DD)

Factory setting

2010-01-01

HART Output Submenu

Assign current output (PV)

Navigation Expert > Communication > HART output > Assign current output (PV)
Description Use this function to assign a measured variable to the primary HART value (PV).
Options » Sensor 1 (measured value)

» Sensor 2 (measured value)

» Device temperature

» Average of the two measured values: 0.5 x (SV1+SV2)

» Difference between sensor 1 and sensor 2: SV1-SV2

» Sensor 1 (backup sensor 2): If sensor 1 fails, the value of sensor 2
automatically becomes the primary HART® value (PV): sensor 1 (OR
sensor 2)

» Sensor switching: If the value exceeds the configured threshold value T for
sensor 1, the measured value of sensor 2 becomes the primary HART®
value (PV). The system switches back to sensor 1 if the measured value of
sensor 1 is at least 2 K below T: sensor 1 (sensor 2, if sensor 1 > T)

» Average: 0.5 x (SV1+SV2) with backup (measured value of sensor 1 or
sensor 2 in the event of a sensor error in the other sensor)

Note: The threshold value can be set with the Sensor switching limit value
parameter. With temperature-dependent switching, it is possible to combine 2
sensors that offer advantages in different temperature ranges.

Factory setting

Sensor 1

PV
Navigation Expert > Communication > HART output > PV
Description Use this function to display the primary HART value.
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Assign SV

Navigation Expert > Communication > HART output > Assign SV

Description Use this function to assign a measured variable to the secondary HART value
(SV).

Options See Assign current output (PV) parameter on page 86.

Factory setting

Device temperature

SV

Navigation Expert > Communication > HART output > SV

Description Use this function to display the secondary HART value.

Assign TV

Navigation Expert > Communication > HART output > Assign TV

Description Use this function to assign a measured variable to the tertiary HART value (TV).
Options See Assign current output (PV) parameter on page 86.

Factory setting

Sensor 1

TV

Navigation Expert > Communication > HART output > TV

Description Use this function to display the tertiary HART value.

Assign QV

Navigation Expert > Communication > HART output > Assign QV

Description Use this function to assign a measured variable to the quaternary (fourth) HART
value (QV).

Options See Assign current output (PV) parameter on page 86.

Factory setting

Sensor 1

Qv
Navigation Expert > Communication > HART output > QV
Description Use this function to display the quaternary HART value.
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4. Operating Menu and Parameter Description

Burst Configuration Submenu

— NOTE

Up to 3 burst modes can be configured.

Burst mode

Navigation Expert > Communication > Burst configuration > Burst mode

Description Activation of the HART burst mode for burst message X. Message 1 has the
highest priority, message 2 the second-highest priority, etc.

Options » Off

The device only sends data to the bus at the request of a HART master
» On
The device regularly sends data to the bus without being requested to do so.

Factory setting

Off

Burst command

Navigation

Expert > Communication > Burst configuration > Burst command

Prerequisite

This parameter can only be selected if the Burst mode option is enabled.

Description Use this function to select the command whose answer is sent to the HART
master in the activated burst mode.
Options » Command 1

Read out the primary variable
» Command 2
Read out the current and the main measured value as a percentage
» Command 3
Read out the dynamic HART variables and the current
» Command 9
Read out the dynamic HART variables including the related status
» Command 33
Read out the dynamic HART variables including the related unit

Factory setting

Command 2

Additional information

Commands 1, 2, 3 and 9 are universal HART commands.
Command 33 is a "Common-Practice" HART command.
More details on this are provided in the HART specifications.
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Burst variable n (a)

Navigation

Expert > Communication > Burst configuration > Burst variable n

Prerequisite

This parameter can only be selected if the Burst mode option is enabled.

Description Use this function to assign a measured variable to slots 0 to 3.
NOTE: This assignment is only relevant for the burst mode. The measured
variables are assigned to the 4 HART variables (PV, SV, TV, QV) in the “HART
Output Submenu” on page 86.

Options » Sensor 1 (measured value)

» Sensor 2 (measured value)

» Device temperature

» Average of the two measured values: 0.5 x (SV1+SV2)

» Difference between sensor 1 and sensor 2: SV1-SV2

» Sensor 1 (backup sensor 2): If sensor 1 fails, the value of sensor 2
automatically becomes the primary HART® value (PV): sensor 1 (OR sensor
2)

» Sensor switching: If the value exceeds the configured threshold value T for
sensor 1, the measured value of sensor 2 becomes the primary HART®
value (PV). The system switches back to sensor 1 if the measured value of
sensor 1 is at least 2 K below T: sensor 1 (sensor 2, if sensor 1 > T)

Note: The threshold value can be set with the Sensor switching limit value
parameter. With temperature-dependent switching, it is possible to combine 2
sensors that offer advantages in different temperature ranges.

Average: 0.5 x (SV1+SV2) with backup (measured value of sensor 1 or sensor 2
in the event of a sensor error in the other sensor)

Factory setting

» Burst variable slot 0: sensor 1
» Burst variable slot 1: device temperature
» Burst variable slot 2: sensor 1
» Burst variable slot 3: sensor 1

a. n = Number of burst variables (0 to 3)
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4. Operating Menu and Parameter Description

Burst trigger mode

Navigation Expert > Communication > Burst configuration > Burst trigger mode
Prerequisite This parameter can only be selected if the Burst mode option is enabled.
Description Use this function to select the event that triggers burst message X.
Note:
» Continuous:
The message is triggered in a time-controlled manner, at least observing the
time
» interval defined in the Burst min period X parameter.
» Window:
The message is triggered if the specified measured value has changed by
the value defined in the Burst trigger level X parameter.
» Rising:
The message is triggered if the specified measured value exceeds the value
in the Burst trigger level X parameter.
» Falling:
The message is triggered if the specified measured value falls below the
value in the Burst trigger level X parameter.
» « On change:
The message is triggered if a measured value of the message changes.
Options » Continuous
» Window
» Rising
» Falling
» On change
Factory setting Continuous

Burst trigger level

Navigation

Expert > Communication > Burst configuration > Burst trigger level

Prerequisite

This parameter can only be selected if the Burst mode option is enabled.
Description

Description Use this function to enter the value which, together with the trigger mode,
determines the time of burst message 1. This value determines the time of the
message.

User entry -1.0e*?0 to +1.0e+20

Factory setting

-1.0e*20

Burst min period

Navigation Expert > Communication > Burst configuration > Burst min period

Prerequisite This parameter can only be selected if the Burst mode option is enabled.

Description Use this function to enter the minimum time span between two burst commands
of burst message X. The value is entered in the unit 1/32 milliseconds.

User entry 500 to [value entered for the maximum interval in the Burst max period parameter]

in whole numbers,

Factory setting

1000
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Burst max period

Navigation

Expert > Communication > Burst configuration > Burst max period

Prerequisite

This parameter can only be selected if the Burst mode option is enabled.

Description Use this function to enter the maximum time span between two burst commands
of burst message X. The value is entered in the unit 1/32 milliseconds.
User entry [Value entered for the minimum interval in the Burst min period parameter] to

3600000 in whole numbers

Factory setting

2000

Diagnostics Submenu

Diagnostic List Submenu

For details, see “Diagnostic List Submenu” on page 73.

Event Logbook Submenu

For details, see “Event Logbook Submenu” on page 74.

Device Information Submenu

Extended order code 1-3
Navigation Expert > Diagnostics > Device information > Extended order code 1-3
Description Use this function to display the first, second and/or third part of the extended
order code. On account of length restrictions, the extended order code is split into
a maximum of 3 parameters.
The extended order code indicates the version of all the features of the product
structure for the device and thus uniquely identifies the device. It can also be
found on the nameplate.
NOTE: Uses of the extended order code
» To order an identical spare device.
» To check the ordered device features using the delivery note.
ENP version
Navigation Expert > Diagnostics > Device information > ENP version
Description Displays the version of the electronic nameplate.
Display 6-digit number in the format xx.yy.zz

Device revision

Navigation Expert > Diagnostics > Device information > Device revision
Expert > Communication > HART info > Device revision

Description Use this function to view the device revision with which the device is registered
with the HART Communication Foundation. It is needed to assign the appropriate
device description file (DD) to the device.

Display 2-digit hexadecimal number
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4. Operating Menu and Parameter Description

Manufacturer ID

Navigation Expert > Diagnostics > Device information > Manufacturer 1D

Description Use this function to view the manufacturer ID with which the device is registered
with the HART Communication Foundation.

Display 2-digit hexadecimal number

Factory setting

17

Manufacturer
Navigation Expert > Diagnostics > Device information > Manufacturer
Description Displays the manufacturer name.

Hardware revision

Navigation Expert > Diagnostics > Device information > Hardware revision
Expert > Communication > HART info > Hardware revision
Description Use this function to display the hardware revision of the device.

Measured Value Submenu

Sensor n raw value

NOTE: n = Stands for the number of sensor inputs (1 and 2)

Navigation Expert > Diagnostics > Measured value > Sensor n raw value
Description Use this function to display the non-linearized mV/Ohm value at the specific
sensor input.
Min/Max Values Submenu

For details, see “Min/Max values Submenu” on page 76.

Simulation Submenu

For details, see “Simulation Submenu” on page 77.
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The RTT80-T Transmitter basic unit has no moving parts and is a completely sealed unit. If there
is a problem, refer to the following troubleshooting section for possible corrective actions.

A CAUTION

RISK OF VOIDING WARRANTY

The basic transmitter is completely sealed unit and cannot be repaired. Any attempt to open the
basic transmitter voids the warranty.

Failure to follow these instructions can void the warranty.

A DANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

For nonintrinsically safe installations, to prevent a potential explosion in a Division 1 hazardous
area, deenergize the transmitter before you remove the threaded housing cover. Failure to
comply with this warning could result in an explosion resulting in severe injury or death.

Failure to follow these instructions can result in death or serious injury.
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Troubleshooting

Table 16. Recommended Troubleshooting Steps Before Replacing Module

Indication Action

Erratic Measurement Check Wiring Connections — Look for any loose connections or corroded
terminals

Check Sensor — See instrument diagnostics (a) or use a multimeter to
measure sensor

Check Grounding — Look for ground loops or noise on the bus with a digital
scope

Check Power Supply — Check for adequate power levels
Check that the sensor type configured matches the sensor type being used

Inaccurate Measurement Check Sensor - See instrument diagnostics (a) or use a multimeter to
measure sensor

Check Grounding - Look for ground loops or noise on the bus with a digital
scope

Check Sensor Calibration — User multimeter to approximate sensor input or
use a temperature bath for more accuracy

Check Transmitter Calibration — Use a decade box or millivolt input to
simulate sensor output

Check Instrument Configuration — Check configured ranges and check for
any unintentional rescaling

Device will not Communicate Check Instrument Configuration — Check for correct addressing, correct
tagging, and so forth. (digital communications)

Check Power Supply— Check for adequate power levels. Check signal
strength at I/O card

Check Grounding — Look for ground loops or noise on the bus with a digital
scope

Check that there is a minimum of 250 € loop resistance between the power
supply and the HART Communicator

Transmitter is in Failsafe Check Sensor — See instrument diagnostics (a) or use a multimeter to
measure sensor

Check Wiring Connections — Look for any loose connections or corroded
terminals

Check Configuration (Ranges, sensor type, and so forth.)

Check Transmitter Calibration — Use a decade box or millivolt input to
simulate sensor output

a. Using a HART Communicator or PC-Based Configurator.
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Figure 39. Troubleshooting Diagram
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Replacing the Transmitter

96

DIN Rail Mounted Units

1.
2.

Turn off the transmitter power source.

If the optional display is present, unplug the display from the transmitter by gently
pulling it away.

Disconnect all wires from the transmitter noting which wire went to each terminal.

4. Remove the transmitter by removing the screw and the bushing that secures it to the

DIN Clip.

Install the new transmitter by reversing Steps 1 to 4 above and torque the screw to
8 1 in-lb.

Dual Compartment Housing Mounted Units

1.
2.
3.

Turn off the transmitter power source.
Remove the housing cover.
If the optional display is present, unplug the display from the transmitter by gently
pulling it away.
Disconnect all the color-coded wires from the transmitter, and note which wire went
to each terminal:
Terminal 1 Red
Terminal 2 Brown
Terminal 3 Orange
Terminal 4 Yellow
Terminal 5 Green
Terminal 6 Blue
Terminal 7 Purple
Remove the transmitter by loosening the two screws that secure it to the mounting
plate.
Install the new transmitter by reversing Steps 1 to 5 above and torquing the screws to
7 +1 in-lb.
— NOTE

It is recommended that the screws be replaced when the transmitter is replaced.

5. Maintenance
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A WARNING

RISK OF MOISTURE INGRESS

To maintain IEC IP66/IP67 and NEMA Type 4X protection on transmitters with dual
compartment housings, plug any unused conduit opening with the metal plug provided. In
addition, the threaded housing cover must be installed. Hand-tighten the cover so that the
o-ring is fully captured, making sure that the flange of the cover comes into contact with the
flange of the housing.

Failure to follow these instructions can result in death or serious injury.

Diagnostics

Diagnostic error messages may be manifested either by the optional display or by a means of

device interface, such as DD or DTM.

Diagnostic errors are communicated in four levels as listed below:

Table 17. Diagnostic Errors

Diagnostic
Symbol Category Description

F Device Failure The measured value is no longer valid.

M Maintenance Required The measurement is valid but device maintenance should be
scheduled soon.

C Service Mode The device is operating correctly but it has been taken out of
service and the measurement may not be valid.

S Out of Specification The device is operating outside of prescribed specification
limits. Measurement may be valid.

Some diagnostic events may be configured to one or more of the above categories.

Diagnostic severity can be categorized as described below:

1able 18. Diagnostic Severity

Severity Behavior

Alarm The measurement is interrupted. The device will take on the failure
condition that has been prescribed (i.e. failsafe). Diagnostic messages
will reference the Device Failure (F) category.

Warning The device continues to communicate a measurement. Diagnostic
message will reference the Maintenance Required (M), Service (C) or
Out of Specification (S) category.

Some diagnostic events may be user-configured for severity.
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Display

The optional display will annunciate a diagnostic event.

5. Maintenance

In the event of a warning, the display will alternate between the diagnostic code number preceded
by the category (M, C or S) symbol and the configured measurement. For example, a corroded
sensor that is configured for a Maintenance category will display M042 on black background
alternating with the measurement in a normal format (black characters on green background).

In the event of an alarm, the display will alternate between the diagnostic code number preceded

by the F symbol and ---- to indicate no measurement. For example, a broken sensor with no
redundancy will display FO41 on black alternating with ---- in black characters on green
background.

See Table 19 for diagnostic codes and descriptions.

The optional display will show the current diagnostic with the highest priority. If more than one
diagnostic is active, all current diagnostic messages can be read using a Device Interface.

Device Interface

Diagnostic messages can be read via a device interface, such as an SDC 625 (HART-compliant)
host, hand-held configurator or Field Device Tool frame application such as a DTM. More
detailed information is available with these interfaces.

See the “Diagnostics Menu” on page 72 section for details of configuring diagnostics. See MI
020-520 for RT'T80 diagnostics DTM screens.

Table 19. Diagnostic Events

Status
tsr:genpaal(:trg:n Diagnostic
Y | Behavior
Diagnostic Can be from the
Number Short Text Corrective Measures Changed to | Factory
Diagnostics for the Sensor
001 Device malfunction 1. Reboot device. F Alarm
2. Check electrical connection of sensor.
3. Check/replace sensor.
4. Replace electronics.
006 Redundancy active 1. Check electrical wiring. M Warning
2. Replace sensor.
3. Check connection type.
041 Sensor broken 1. Check electrical wiring. F Alarm
2. Replace sensor.
3. Check connection type.
042 Sensor corroded 1. Check electrical wiring of sensor. M Warning (a)
2. Replace sensor. F
043 Short circuit 1. Check electrical wiring. F Alarm
2. Replace sensor.
044 Sensor drift 1. Check sensors. M Warning
2. Check process temperatures. F S
045 Working area 1. Check ambient temperature. F Alarm
2. Check external reference measuring point.
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1able 19. Diagnostic Events (Continued)

Status
gl rom  iagnostic
Y | Behavior
Diagnostic Can be from the
Number Short Text Corrective Measures Changed to | Factory
062 Sensor connection 1. Check electrical connection of sensor. F Alarm
2. Replace sensor.
3. Check sensor configuration.
4. Contact service.
101 Sensor value too low 1. Check process temperatures. S Warning
2. Inspect sensor. F
3. Check sensor type.
102 Sensor value too high 1. Check process temperatures. S Warning
2. Inspect sensor. F
3. Check sensor type.
104 Backup active 1. Check electrical wiring of sensor 1. M Warning
2. Replace sensor 1.
3. Check connection type.
105 Calibration interval 1. Execute calibration and reset M Warning
calibration interval. F
2. Switch off calibration counter.
106 Backup not available 1. Check electrical wiring of sensor 2. M Warning
2. Replace sensor 2.
3. Check connection type.
Diagnostics for the Electronics
201 Device malfunction Replace electronics. F Alarm
221 Reference measurement |Replace electronics. F Alarm
241 Software 1. Restart device. F Alarm
2. Perform device reset.
3. Replace device.
242 Software incompatible Contact service. F Alarm
261 Electronics module Replace electronics. F Alarm
262 Module connection short |1. Ensure that display module is correctly M Warning
circuit seated on the transmitter.
2. Test the display module using other
suitable transmitters.
3. Display module defective? Replace
module.
282 Electronic memory Replace device. F Alarm
283 Memory content Replace electronics. F Alarm
301 Supply voltage 1. Increase supply voltage. F Alarm
2. Check connection wires for corrosion.
Diagnostics for the Configuration
401 Factory reset Wait until the reset procedure is complete. C Warning
402 Initialization Wait until start-up procedure is complete C Warning
410 Data transfer Check HART communication. F Alarm
411 Upload/download Wait until the upload/download is complete. |F, M, or C (b) -
431 Factory calibration (c) Replace electronics. F Alarm
435 Linearization 1. Check configuration of sensor parameters. F Alarm
2. Check configuration of special sensor
linearization.
3. Contact service.
4. Replace electronics.
437 Configuration 1. Check configuration of sensor parameters. F Alarm
2. Check configuration of special sensor
linearization.
3. Check configuration of transmitter settings.
4. Contact service.
438 Dataset Repeat the safe parameterization. F Alarm
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1able 19. Diagnostic Events (Continued)

Status
tsr:gn:;::gx Diagnostic
Behavior
Diagnostic Can be from the
Number Short Text Corrective Measures Changed to | Factory
451 Data processing Wait until data processing is C Warning
complete.
483 Simulation input Deactivate simulation. C Warning
485 Measured value
simulation
491 Simulation current output
501 CDI connection Unplug CDI connector. C Warning
525 HART communication 1. Check communication path (Hardware). F Alarm
2. Check HART-master.
3. Check if power is sufficient.
4. Check HART communication settings.
5. Contact service organization.
Diagnostics for the Process
803 Current loop 1. Check wiring. F Alarm
2. Replace electronics.
842 Process limit value Check scaling of analog output. M Warning
F.S
925 Device temperature Observe ambient temperature in accordance S Warning
with specification. F

a. Diagnostic behavior can be changed in Alarm or Warning.
b. Status signal depends on used communication system and cannot be changed.
c. In the case of this diagnostics event, the device always issues a “low” alarm status (output current < 3.6 mA).
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